
Design Guide: TIDM-02018
AM263x Arm® ベースの MCU デバイス向けユニバーサル モー
ター制御のリファレンス デザイン

概要

このリファレンス デザインは、テキサス・インスツルメンツの 

AM263x Arm® ベースの MCU 向けユニバーサル モータ

ー制御の設計を示しています。このデザインでは、センサ
レス (eSMO) およびセンサ付き (インクリメンタル エンコー

ダ、ホール センサ) など、さまざまなタイプの FOC モータ

制御方式に AM263x MCU を使用する方法を紹介してい

ます。このデザインは、AM263x LaunchPad™ と 

3PHGANINV BoosterPack™ を使用した低電圧設定と、

AM263x controlCARD™ と TMDSHVMTRINSPIN モー

ター制御キットを使用した高電圧設定という、2 つの主要

なハードウェア設定をサポートしています。また、ドキュメン
トではカスタム ボードへの移行方法、および新しいデバイ

スへのプロジェクトのポーティング方法についても説明して
います。

参照情報
TIDM-02018 デザイン フォルダ

AM2634-Q1 プロダクト フォルダ

AM263x MCU+ SDK ツール フォルダ

AM263x Academy 学習用教材

テキサス・インスツルメンツの™ E2E サポ

ート エキスパートにお問い合わせくださ

い。

特長

• このリファレンス デザインに関する包括的なソフトウェ

ア パッケージ、ツール、ドキュメントは、AM263x MCU 
をベースとするモーター制御システムの開発期間の短
縮できるようにします。

• さまざまな FOC モーター制御方式：センサレス 

(eSMO) およびセンサ付き (インクリメンタル エンコー

ダ、ホール センサ) 制御がサポートされています。

• 多くの 3 相インバータ モーター評価キットと互換性の

ある テキサス・インスツルメンツのシステム機能とデバッ

グ インターフェイスが含まれています。

• Sysconfig ベースのプロジェクトでは、異なるデバイス

やボード間でも簡単に移行できます。これは、ピン、ペ
リフェラル、ソフトウェア スタック、クロック ツリー、その

他の要素を調整できる使いやすいグラフィカル ユーザ

ー インターフェイスによって実現され、ソフトウェア開発

がスピードアップします。

アプリケーション

• HEV/EV のインバータおよびモーター制御

• モーター ドライブ

• AC インバータと VF ドライブ

• AC ドライブ制御モジュール

+

Space 

Vector 

PWM

V�
* 

w
*

3-phase 

Inverter

PWM1A

PWM1B

PWM2A

PWM2B

PWM3A

PWM3B

d-q

�-�  

V�
* Vd

* 

Vq
* 

id
* 

iq
* 

PI

PI

-

a-b-c

�-�  d-q

�-�  

eSMO

PI

FWC

+

MTPA

+

-

+

-

�e 
 ^

	e 
 ^

id

iq

iq

id

Vdc  
  

i
 
 

i� 
 

ia

ib

ic

we 
 ^

we 
 ^

PMSM

www.ti.com/ja-jp 概要

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

1

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

参考資料

https://www.ti.com/tool/TIDM-02018
https://www.ti.com/product/jp/AM2634-Q1
https://www.ti.com/tool/MCU-PLUS-SDK-AM263X
https://dev.ti.com/tirex/explore/node?node=A__AKM3smmsVVn7tYZAiWfuSA__AM26X-ACADEMY__t0CaxbG__LATEST
https://e2e.ti.com/support/applications/ti_designs/
https://e2e.ti.com/support/applications/ti_designs/
https://www.ti.com/applications/automotive/hev-ev-powertrain/hev-ev-inverter-motor-control/overview.html
https://www.ti.com/applications/industrial/motor-drives/overview.html
https://www.ti.com/applications/industrial/motor-drives/ac-inverter-vf-drives/overview.html
https://www.ti.com/solution/ac-drive-control-module
https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


1 システムの説明

このリファレンス デザインで説明するユニバーサル モーター制御プロジェクトは、さまざまなモーター制御アルゴリズムを

試してみるだけでなく、独自の設計のリファレンスとして使用することを目的としています。この単一プロジェクトにはさまざ
まなビルド構成オプションがあり、テキサス・インスツルメンツのシステム機能やデバッグ インターフェイスとともに、センサレ

ス (eSMO) およびセンサ付き (インクリメンタル エンコーダ、ホール センサ) を含むさまざまな FOC モーター制御方式を

利用できます。このプロジェクトでは、データ ロギング、ソフトウェア周波数応答アナライザ (SFRA)、モーター PI 調整、弱

め界磁、アンペアあたり最大トルク (MPTA)、CPU 時間計算、EPWM DAC モード、ステップ応答モジュール、位相調整

などのさまざまな機能を提供しています。このリファレンス デザインでは、TI.com から注文できる 2 つのハードウェア キッ

トの評価を行っています。

• BOOSTXL-3PHGANINV + LVSERVOMTR + LP-AM263
• TMDSHVMTRINSPIN + HVPMSMMTR + TMDSCNCD263

1.1 用語

FOC フィールド オリエンテッド コントロール

eSMO 拡張スライディング モード オブザーバ

PMSM 永久磁石同期型モーター

EEMF 拡張起電力

PLL 位相ロック ループ

IPMS 内部 PMSM
FW 弱め界磁

MTPA 最大トルク / 電流

SVPWM 空間ベクトル変調

PWM パルス幅変調

RPM 回転数 / 分

1.2 主なシステム仕様

• シャント方式のインライン モーター位相電流センシング評価ボードを搭載した 48V 3 相インバータの詳細について

は、BOOSTXL-3PHGANINV のデザイン ファイルおよび技術資料を参照してください。

• 高電圧モーター制御キットの詳細については、TMDSHVMTRINSPIN を参照してください。

• 低電圧サーボ モーター、エンコーダ、ワイヤ ハーネスの詳細については、LVSERVOMTR のデータシートを参照して

ください。
• 高電圧永久磁石同期モーターの詳細については、HVPMSMMTR のデータシートを参照してください。
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2 システム概要

2.1 ブロック図
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図 2-1. PMSM モーターの eSMO ベース センサレス FOC のブロック図

2.2 主な使用製品

2.2.1 AM263x マイクロコントローラ

AM263x Arm® ベースのマイクロコントローラは、次世代の産業用および車載用組込み製品の複雑なリアルタイム処理ニ

ーズを満たすように構成されています。AM263x MCU ファミリは、最大 4 つの 400MHz Arm® Cortex®-R5F コアを内蔵

した複数のピン互換デバイスで構成されています。複数の Arm® コアを任意にプログラミングして、各種の機能安全構成

用にロックステップのオプションで動作させることもできます。産業用通信サブシステム (ICSS) を使用すると、PROFINET 
IRT、TSN、EtherCAT® など (その他多数) の内蔵の産業用イーサネット通信、または標準的なイーサネット コネクティビ

ティやカスタム I/O インターフェイスを実現できます。AM263x ファミリは、高度なアナログ モジュールを使用した高度モー

ター制御およびデジタル電源制御アプリケーション用に設計されています。

2.2.1.1 TMDSCNCD263

AM263x controlCARD 評価ボード (EVM) は、テキサス・インスツルメンツの Sitara™ AM263x シリーズのマイクロコント

ローラ (MCU) 用の評価 / 開発ボードです。この EVM には、プログラミングおよびデバッグ用のオンボード エミュレーショ

ンが搭載され、ボタンや LED を備えたシンプルなユーザー インターフェイスを利用できるため、AM263x MCU でのトラク

ション インバータの開発を簡単に始めることができます。また、この controlCARD を使用すると、ヘッダー ピンからキーに

アクセスして、迅速にプロトタイプを製作できます。

図 2-2. AM263x controlCARD™
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2.2.1.2 LP-AM263

LP-AM263 は、Sitara™ 高性能マイクロコントローラ (MCU) である AM263x シリーズ向けのコスト最適化済み開発ボー

ドです。このボードは、新しいアプリケーションを開発するための標準化された使いやすいプラットフォームを実現できるの
で、初期評価やプロトタイプ製作に最適です。

LP-AM263 は、Sitara AM2634 プロセッサと付加的なコンポーネントを採用しています。開発ユーザーは、産業用イーサ

ネット (IE)、標準的なイーサネット、高速シリアル インターフェイス (FSI) などの各種デバイス インターフェイスを使用し

て、プロトタイプを容易に製作できます。AM2634 は、EtherCAT、EtherNet/IP、PROFINET® などのさまざまな IE (産業

用イーサネット) プロトコルをサポートしています。

図 2-3. AM263x LaunchPad™
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3 システム設計理論

3.1 3 相 PMSM 駆動

永久磁石同期モーター (PMSM) は、巻線固定子、永久磁石回転子アセンブリ、回転子位置をセンシングする内部デバ

イスや外部デバイスを備えています。センシング デバイスは、磁石アセンブリの回転を維持するために、固定子電圧リファ

レンスの周波数と振幅を適切に調整するための位置帰還を提供するものです。内部の永久磁石回転子と外部巻線を組
み合わせることで、回転子の慣性が小さく、放熱が効率的で、モーターを小型化できるという利点があります。

• 同期モーターの構造：永久磁石は回転軸にしっかりと固定され、一定の回転子フラックスを生み出します。この回転子
フラックスの振幅は通常一定の大きさです。通電されると、固定子巻線によって回転磁場が生成されます。回転磁場を
制御するには、固定子電流を制御する必要があります。

• 回転子の実際の構造は、機械の出力範囲と定格速度によって異なります。数キロワットまでの同期機には、永久磁石
が最も適しています。高電力定格の場合、回転子は通常 DC 電流が循環する巻線で構成されます。回転子の機械的

構造は、必要な極数と必要なフラックス勾配に応じて設計されます。
• 固定子フラックスと回転子フラックスの相互作用によってトルクが生成されます。固定子はフレームにしっかりと取り付け

られ、回転子は自由に回転できるため、図 3-1 に示すように、回転子が回転することにより実際の機械的出力が得ら

れます。
• 最大トルクを生成して、高い電気機械的変換効率を達成するには、回転子磁場と固定子磁場の間の角度を慎重に制

御する必要があります。このためには、センサレス アルゴリズムを使用して速度ループを閉じた後、速度とトルクが同じ

条件のもとで最小量の電流を流すように微調整する必要があります。
• 回転する固定子磁場は、回転子の永久磁場と同じ周波数で回転する必要があります。そうでない場合、回転子には

正と負のトルクが急速に交互に発生します。その結果、最適なトルクが得られなくなり、機械部品に過度の機械的な振
動やノイズ、機械的ストレスが生じることになります。さらに、回転子の慣性が原因で、回転子がこれらの振動に応答で
きなくなると、回転子は同期周波数での回転を停止し、静止している回転子から見た平均トルク、つまりゼロに反応す
ることになります。これは機械がプルアウトと呼ばれる現象を起こしていることを意味しており、 同期機が自己起動しな

い理由でもあります。
• 最高の相互トルク生成を実現するには、回転子磁場と固定子磁場の間の角度が 90° でなければなりません。この同

期化には、回転子の位置を把握して、適切な固定子の磁場を生成する必要があります。
• 固定子の磁場は、異なる固定子相からの影響を組み合わせて固定子フラックスを生成することにより、任意の方向と大

きさにすることができます。

図 3-1. 回転する固定子フラックスと回転子フラックスの相互作用によって生成されるトルク

3.1.1 PMSM の数学モデルと FOC 構造

PMSM の FOC 構造を 図 2-1 に示します。このシステムでは、IPMSM システムのセンサレス制御を実現するために 

eSMO を使用し、eSMO モデルは、逆起電力モデルと PLL モデルを組合せて、回転子の位置と速度を推定するように

設計されています。

IPMSM は、3 相の固定子巻線 (a 軸、b 軸、c 軸) と励起用の永久磁石 (PM) 回転子で構成されています。モーターは、

標準的な 3 相インバータによって制御されます。IPMSM は 位相 a-b-c の量を用いてモデル化できます。適切な座標変
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換を行うことで、PMSM の動的モデルを d-q 回転リファレンス フレームと α-β 固定リファレンス フレームで実現できます。

これらのリファレンス フレームは 式 1 のような関係にあります。一般的な PMSM の動的モデルは、d-q 回転リファレンス 

フレームにおいて次のように記述できます。vdvq = Rs+ pLd −ωeLqωeLd Rs+ pLq idiq + 0ωeλpm (1)

ここで、

• Vd は、q 軸の固定子端子電圧です

• Vq は、d 軸の固定子端子電圧です

• id は、d 軸の固定子電流です

• iq は、q 軸の固定子電流です

• Ld は、q 軸のインダクタンスです

• Lq は、d 軸のインダクタンスです

• p は、微分演算子です

• 式 2 の短い表記は、永久磁石によって生成される磁束結合です

• RS は、固定子巻線の抵抗です

• ωe は、回転子の電気角速度ですddt ; λpm (2)
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図 3-2. PMSM モデル化のための座標リファレンス フレームの定義

図 3-2 に示すように逆パーク変換を使用することで、PMSM の動的特性は、次に示すように α-β 固定リファレンス フレー

ムでモデル化できます。vαvβ = Rs+ pLd ωe Ld− Lq−ωe Ld− Lq Rs+ pLq iαiβ + eαeβ (3)

eα および eβ は、α-β 軸の拡張起電力 (EEMF) の成分であり、次に示すように定義できます。 eαeβ = λpm+ Ld− Lq id ωe −sin θecos θe (4)
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式 3 と 式 4 によると、等価変換と EEMF の概念を導入することで、回転子の位置情報はインダクタンス マトリックスから

切り離すことができ、その結果、EEMF が回転子の極位置情報を含む唯一の項となります。さらに、EEMF の位相情報を

そのまま回転子の位置観測に利用することができます。固定子電流を状態変数として、IPMSM の電圧 式 5 を状態式に

書き換えます。i̇αi̇β = 1Ld −Rs −ωe Ld− Lqωe Ld− Lq −Rs iαiβ + 1Ld Vα− eαVβ− eβ (5)

直接測定できる唯一の物理量は固定子電流であるため、スライディング サーフェスは固定子電流の経路上で選択されま

す。

S x = iα− iαiβ− iβ = i αi β (6)

ここで、

• 式 7 および 式 8 は、推定電流です。

• 上付きの添え字 ^ は推定値を示します。

• 上付きの添え字 ˜ は、観測値と実測値との差を意味する変数誤差を示します。iα (7)iβ (8)

3.1.2 PM 同期モーターの磁界方向制御

より優れた動的性能を実現するには、より複雑な制御方式を適用して PM モーターを制御する必要があります。マイクロコ

ントローラがもたらす数学的処理能力により、PM モーターのトルク生成と磁化機能をデカップリングする数学的変換を使

用した高度な制御方式を実装できます。トルクと磁化をデカップリングするこのような制御は、一般的に回転子フラックス 
オリエンテッド コントロール、または単にフィールド オリエンテッド コントロール (FOC) と呼ばれます。

図 3-3 に示すように、直流 (DC) モーターでは、固定子と回転子の励磁は別々に制御され、生成されたトルクとフラックス

は別々の調整が可能です。界励磁の強さ (たとえば、界励磁電流の大きさ) によって、フラックスの値が設定されます。回

転子巻線に流れる電流によって、生成されるトルクの大きさが決まります。トルク生成において特に興味深い役割を果た
すのが、回転子の整流子です。整流子はブラシと接触しており、機械的構造上、最大トルクを生成するように機械的に整
列された巻線が回路に切り替わるように設計されています。この配置によって、機械のトルク生成は常に最適にかなり近い
状態になります。ここで重要なポイントは、回転子巻線によって生成されるフラックスが固定子磁場と直交するように巻線が
制御されていることです。

より優れた動的性能を実現するには、より複雑な制御方式を適用して PM モーターを制御する必要があります。マイクロコ

ントローラがもたらす数学的処理能力により、PM モーターのトルク生成と磁化機能をデカップリングする数学的変換を使

用した高度な制御方式を実装できます。トルクと磁化をデカップリングするこのような制御は、一般的に回転子フラックス 
オリエンテッド コントロール、または単にフィールド オリエンテッド コントロール (FOC) と呼ばれます。

図 3-3 に示すように、直流 (DC) モーターでは、固定子と回転子の励磁は別々に制御され、生成されたトルクとフラックス

は別々の調整が可能です。界励磁の強さ (たとえば、界励磁電流の大きさ) によって、フラックスの値が設定されます。回

転子巻線に流れる電流によって、生成されるトルクの大きさが決まります。トルク生成において特に興味深い役割を果た
すのが、回転子の整流子です。整流子はブラシと接触しており、機械的構造上、最大トルクを生成するように機械的に整
列された巻線が回路に切り替わるように設計されています。この配置によって、機械のトルク生成は常に最適にかなり近い
状態になります。ここで重要なポイントは、回転子巻線によって生成されるフラックスが固定子磁場と直交するように巻線が
制御されていることです。
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図 3-3. フラックスとトルクが別々に制御される DC モーター モデル

同期機と非同期機の FOC (ベクトル制御とも呼ぶ) の目的は、トルク生成成分とフラックス磁化成分を別々に制御できるよ

うにすることです。FOC 制御を使用すると、固定子電流のトルク生成成分とフラックス磁化成分をデカップリングできます。

磁化のデカップリング制御を行うことで、固定子フラックスのトルク生成成分は独立したトルク制御として考えることができる
ようになりました。トルクとフラックスをデカップリングするには、いくつかの数学的変換を行いますが、ここでマイクロコントロ
ーラが最も価値を発揮します。マイクロコントローラによる処理能力によって、このような数学的変換を非常に高速で行うこ
とができます。これは、モーターを制御するアルゴリズム全体を高速で実行できることを意味し、より高度な動的性能が実
現できるのです。現在では、デカップリングに加えて、回転子フラックスの角度や回転子の速度など、数多くの量の計算に
モーターの動的モデルが使用されています。つまり、これらの効果が考慮されて、全体的な制御の質が向上しているので
す。

電磁法則によれば、同期機で生成されるトルクは、式 9 に示すように、既存の 2 つの磁場のベクトル外積に等しくなりま

す。

τem = Bstator × B rotor (9)

この式は、固定子と回転子の磁場が直交している場合、つまり負荷が 90 度である場合にトルクが最大になることを示して

います。この状態を常に維持でき、フラックスを正しい方向に向けることができれば、トルク リップルを減らし、より優れた動

的応答を維持することができます。ただし、回転子の位置を把握していなければならないという制約があります。インクリメ
ンタル エンコーダのような位置センサを使用すると実現できます。回転子にアクセスできないような低コストのアプリケーシ

ョンでは、位置センサを排除するために異なる回転子位置オブザーバ方式が適用されます。

簡単に説明すると、回転子フラックスと固定子フラックスを直交させた状態で維持することです。固定子フラックスを回転子
フラックスの q 軸に、たとえば回転子フラックスに直交するように合わせることが目標です。そのために、回転子フラックスと

直交する固定子電流成分は指令されたトルクを生成するように制御され、直接成分はゼロに設定されます。固定子電流
の直接成分は場合によって弱め界磁に使用することができ、回転子フラックスを逆向きにし、逆 EMF を減少させるので、

より高速での動作が可能になります。

フィールド オリエンテッド コントロールは、ベクトルで表される固定子電流を制御します。この制御は、時間と速度に依存

する 3 相座標系が時不変の 2 座標系 (d 座標と q 座標) に変換される投影に基づいています。このような投影によって、

DC 機制御と同じような構造になります。フィールド オリエンテッド コントロールに基づいている機械は、入力リファレンスと

して、トルク成分 (q 座標) とフラックス成分 (d 座標) の 2 つの定数を必要とします。フィールド オリエンテッド コントロール

は単純に投影に基づいているため、制御構造が瞬間的な電気量を取り扱います。これによって、あらゆる動作 (定常状態

と過渡状態) について正確な制御が実現し、帯域幅に制限がある数学モデルに依存することがありません。これにより、

FOC は従来の方式の問題を次のように解決します。

• 一定のリファレンスに到達しやすい (固定子電流のトルク成分とフラックス成分)
• (d, q) リファレンス フレームではトルクの式が 式 10 で定義されることから、直接トルク制御が適用しやすいτem ∝ ψR × isq (10)

回転子フラックス (ψR) の振幅を固定値に保つことで、トルクとトルク成分 (ISq) の間に線形関係が得られます。固定子電

流ベクトルのトルク成分を制御することで、トルクを制御できます。
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3.1.2.1 (a, b) → (α, β) クラーク変換

空間ベクトルは、直交する 2 つの軸 (α, β) だけを持つ別のリファレンス フレームで表すことができます。a 軸と αlpha 軸
が同じ方向であると仮定すると、図 3-4 のようなベクトル図になります。

図 3-4. 固定リファレンス フレームの固定子電流空間ベクトル

3 相座標系を (α, β) 2 次元直交系に変更する投影を 式 11 に示します。isα = iaisβ = 13 ia+ 23 ib (11)

2 相 (α、β) 電流は、依然として時間と速度に依存します。

3.1.2.2 (α, β) → (d, q) パーク変換

これは FOC における最も重要な変換です。実際には、この投影は (d, q) 回転リファレンス フレームの 2 相直交座標系 

(α, β) を変更するものです。d 軸が回転子フラックスと一直線上にあるものとして、図 3-5 に 2 つのリファレンス フレーム

の電流ベクトルの関係を示しています。

図 3-5. (d, q) 回転リファレンス フレームの固定子電流空間ベクトル

電流ベクトルのフラックス成分とトルク成分は 式 12 で決定されます。isd = isαcos θ + isβsin θisq = − isαsin θ + isβcos θ (12)
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θ は回転子フラックスの位置です。

これらの成分は、電流ベクトル (α、β) の成分と回転子フラックスの位置に依存します。適切な回転子フラックスの位置がわ

かると、この投影によって d、q 成分は一定になります。これで 2 相電流は DC 量 (時不変) に変わります。この時点で、

一定の isd (フラックス成分) と isq (トルク成分) の電流成分が別々に制御されるため、トルク制御が容易になります。

3.1.2.3 AC モーターの FOC 基本方式

図 3-6 に、FOC によるトルク制御の基本方式をまとめます。

図 3-6. AC モーターの FOC 基本方式

2 つのモーター相電流が測定されて、測定値がクラーク変換モジュールに供給されます。この投影の出力は isα と isβ と
なります。この電流の 2 つの成分は、d、q 回転リファレンス フレームでの電流をもたらすパーク変換の入力です。isd と isq 
成分は、リファレンス isdref (フラックス リファレンス成分) と isqref (トルク リファレンス成分) と比較されます。ここで、この制御

構造に興味深い利点があることがわかります。つまり、フラックス リファレンスを変更して、回転子フラックスの位置を取得

するだけで、同期機と誘導機のどちらを制御するにもこの制御構造を使用できるということです。永久磁石同期モーター
の場合、回転子フラックスは磁石によって固定されているため、フラックスの生成は必要ありません。したがって、PMSM 
を制御する場合、isdref はゼロに設定されます。AC 誘導モーターは動作するために回転子フラックスを生成する必要があ

るため、フラックス リファレンスはゼロであってはなりません。これにより、従来の制御構造の大きな欠点の 1 つである、非

同期ドライブから同期ドライブへの移行が簡単に解決されます。 速度 FOC を使用する場合、トルク指令 isqref を速度レギ

ュレータの出力とすることができます。電流レギュレータの出力は Vsdref と Vsqref であり、逆パーク変換に適用されます。

この投影の出力は、(α、β) 固定直交リファレンス フレームにおける固定子ベクトル電圧の成分である Vsαref と Vsβref であ

り、空間ベクトル PWM の入力になります。このブロックの出力はインバータを駆動する信号です。パーク変換と逆パーク

変換の両方には回転子フラックスの位置が必要になることに注意してください。この回転子フラックスの位置の取得方法
は、AC 機のタイプ (同期機または非同期機) によって異なります。

3.1.2.4 回転子フラックスの位置

FOC では、回転子フラックスの位置情報を把握することが中心となります。実際、この変数に誤差があると、回転子フラッ

クスは d-軸と一直線にならず、isd と isq は固定子電流の正しいフラックス成分とトルク成分とはなりません。図 3-7 は (a、

b、c)、(α、β)、(d、q) の各リファレンス フレームを示し、同期速度で d、q リファレンスで回転する、回転子フラックス、固定

子電流、固定子電圧の各空間ベクトルの正しい位置を示しています。
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図 3-7. 回転リファレンス フレーム (d、q) の電流、電圧、回転子フラックスの各空間ベクトル

同期モーターと非同期モーターでは、回転子フラックス位置の測定方法が異なります。

• 同期モーターでは、回転子速度は回転子フラックス速度と等しくなります。したがって、θ (回転子フラックスの位置) は
位置センサによって直接測定されるか、回転子速度の積分によって求められます。

• 非同期モーターでは、回転子速度は回転子フラックス速度と等しくないため (スリップ速度があるため)、θ の算出には

特定の方法が必要になります。基本的な方法としては、d、q リファレンス フレームにおけるモーター モデルの 2 つの

式を必要とする電流モデルを使用します。

理論的には、PMSM ドライブのフィールド オリエンテッド コントロールにより、DC モーターの動作のようにモーター トルク

をフラックスとは無関係に制御することができます。言い換えれば、トルクとフラックスは互いにデカップリングされているこ
とになります。固定リファレンス フレームから同期回転リファレンス フレームへの変数変換を行うには、回転子位置を知る

必要があります。この変換 (いわゆるパーク変換) の結果、q-軸の電流がトルクを制御し、d-軸の電流は強制的にゼロにな

ります。したがって、このシステムの重要なモジュールは、拡張スライディング モード オブザーバ (eSMO) を使用した回

転子位置の推定になります。

3.1.3 PM 同期モーターのセンサレス制御

家電アプリケーションでは、機械センサを使用することにより、コスト、サイズ、信頼性の問題が増します。これらの問題を克
服するために、センサレス制御方式が導入されています。機械的な位置センサを使用せずに回転子の速度と位置の情報
を取得するために、複数の推定方法が使用されます。スライディング モード オブザーバ (SMO) には、信頼性、期待され

る性能、システム パラメータの変動に対する堅牢性など、数多くの魅力的な特長があるため、一般的に利用されていま

す。

3.1.3.1 位相ロック ループを備えた拡張スライディング モード オブザーバ

モデル ベースの手法を使用して、モーターが中速または高速で動作する場合に、IPMSM ドライブ システムの位置セン

サレス制御を実現しています。モデル ベースの手法では、逆 EMF モデルまたは磁束結合モデルによって回転子位置を

推定します。スライディング モード オブザーバは、スライディング モード制御に基づいたオブザーバの設計手法です。シ

ステムの構造は固定ではなく、システムの現在の状態に応じて意図的に変更され、あらかじめ決められたスライディング 
モードの軌道に従って強制的に動かされます。応答が速く、堅牢性が優れ、パラメータの変化や外部の変動に対して影
響を受けにくいのが利点です。

3.1.3.1.1 PMSM 向け ESMO の設計

図 3-8 に、SMO に組み込まれた通常の PLL を示します。
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図 3-8. PMSM 向け PLL 搭載 eSMO のブロック図

従来の低次スライディング モード オブザーバは、式 13 に示す数学モデルと、図 3-9 に示すブロック図で構築されます。

i̇αi̇β = 1Ld −Rs −ωe Ld− Lqωe Ld− Lq −Rs iαiβ + 1Ld Vα− eα+ zαVβ− eβ+ zβ (13)

ここで、zα および zβ はスライディング モードの帰還成分であり、次のように定義されます。 zαzβ = kαsign iα− iαkβsign iβ− iβ (14)

ここで、kα および kβ はリアプノフ安定性解析によって設計された一定スライディング モード ゲインです。 kα と kβ が正で

あり、SMO の安定動作を維持するのに十分な大きさであるなら、kα と kβ は通常、式 15 と 式 16 を保持するのに十分な

大きさになります。 kα > max eα (15)kβ > max eβ (16)
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図 3-9. 従来のスライディング モード オブザーバのブロック図

α-β 軸における EEMF の推定値 (式 18、式 19) は、不連続スイッチング信号 zα および zβ からのローパス フィルタによ

って得られます。 eαeβ = ωcs + ωc zαzβ (17)

êα (18)êβ (19)

式 20 は LPF のカットオフ角周波数で、通常は固定子電流の基本周波数に応じて選択されます。ωc = 2πfc (20)
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したがって、回転子位置は、次に定義するように、逆起電力のアークタンジェントから直接計算できます。

θe = − tan−1 eαeβ (21)

ローパス フィルタは、スライディング モード関数の高周波項を除去することにより、位相遅延を引き起こします。これは、カ

ットオフ周波数 ωc と逆起電力周波数 ωe の関係を使用して補償できます。これは、次のように定義されます。 

∆θe = − tan−1 ωeωc (22)

次に、SMO 方式によって推定された回転子位置は、次で求められます。

θe = − tan−1 eαeβ + ∆θe (23)

デジタル制御アプリケーションでは、SMO の時間離散式が必要です。時間離散オブザーバに変換するには、オイラー法

が適切です。α-β 座標における 式 13 の時間離散システム マトリックスは、式 24 によって次のように求められます。

i̇α n + 1i̇β n + 1 = FαFβ i̇α ni̇β n + GαGβ Vα* n − eα n + zα nVβ* n − eβ n + zβ n (24)

ここで、行列 [F] と [G] は 式 25 と 式 26 によって次のように求められます。 

FαFβ = e−RsLde−RsLq (25)

GαGβ = 1Rs 1 − e−RsLd1 − e−RsLq (26)

式 17 の時間離散形式は、式 27 によって次のように求められます。eα n + 1eβ n + 1 = eα neβ n + 2πfc zα n − eα nzβ n − eβ n (27)

3.1.3.1.2 PLL による回転子位置および速度の推定

アーク タンジェント法では、ノイズや高調波の成分が存在するため、位置と速度の推定精度に影響が出ます。この問題を

解消するために、IPMSM のセンサレス制御構造では、PLL モデルを速度と位置の推定に使用できます。セクション 

3.1.3.1.1 に、SMO と一緒に使用される PLL 構造を示します。逆起電力の推定値 式 18 および 式 19 を PLL モデルで

使用して、図 3-10 に示すように、モーターの角速度と位置を推定できます。
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図 3-10. 位相ロック ループ位置トラッカーのブロック図

式 28、式 29、および 式 30 から、eα = Ecos θe (28)eβ = Esin θe (29)E = ωeλpm (30)

位置誤差は次のように定義できます。ε = eβcos θe − eαsin θe = Esin θe cos θe − Ecos θe sin θe = Esin θe− θe (31)

E は EEMF の大きさで、モーター速度 ωe に比例します。 式 32 の場合、式 31 は次のように簡略化できます。

θe− θe < π2 (32)

ε = E θe− θe (33)

さらに、EEMF の正規化後の位置誤差を求めることができます。εn = θe− θe (34)

解析に従うと、直角位相ロック ループの位置トラッカーの概略ブロック図は、図 3-11 のようになります。PLL の閉ループ伝

達関数は、次のように表すことができます。

θeθe = kps + kis2 + kps + ki = 2ξωns + ωn2s2 + 2ξωns + ωn2 (35)

ここで、kp と ki は標準的な PI レギュレーターの比例利得と積分利得であり、固有周波数 ωn と減衰比 ξ は次のように与

えられます kp = 2ξωn,     ki = ωn2 (36)
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図 3-11. 位相ロック ループ位置トラッカーの概略ブロック図
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3.1.4 モーター駆動のハードウェア要件

モーターの制御アルゴリズムは、DC バス電源電圧、各モーター相の電流など、モーターの状態に関するサンプリング測

定値を利用します。モーターを正しく識別し、フィールド オリエンテッド コントロール (FOC) を使用してモーターを効果的

に動作させるには、電流スケール値、電圧スケール値、電圧フィルタ極など、正しく設定する必要があるハードウェア依存
のパラメータがいくつかあります。

3.1.5 その他の制御機能

3.1.5.1 弱め界磁 (FW) および最大トルク / 電流 (MTPA) 制御

永久磁石同期モーター (PMSM) は、高電力密度、高効率、幅広い速度範囲により、家電アプリケーションで広く使用さ

れています。PMSM には、表面実装型 PMSM (SPM) と内部実装型 PMSM (IPM) の 2 つの主要なタイプがあります。

SPM モーターは、トルクと q-軸電流が線形関係にあるため、制御が容易になっています。一方、IPMSM には、大きな突

極性比による電磁トルクとリラクタンス トルクがあります。総トルクは、回転子角度に対して非線形です。その結果、IPM モ
ーターで MTPA 技術を使用して、定トルク領域でのトルク生成を最適化することができます。弱め界磁制御は、PMSM ド
ライブの電力と効率を最大限に高めるために最適化することが目的です。弱め界磁制御は、基本速度以上のモーター動
作を可能にし、動作限界を拡大して定格速度を上回る速度に到達させ、速度と電圧の全範囲にわたって最適な制御がで
きるようになります。

IPMSM の数学モデルの電圧式は、式 37 と 式 38 に示すように、d-q 座標で記述できます。

vd = Lddiddt + Rsid− pωmLqiq  (37)

vq = Lqdiqdt + Rsiq+ pωmLdid+ pωmψm (38)

IPM 同期モーターの動的な等価回路を、図 3-12 に示します。
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図 3-12. IPM 同期モーターの等価回路

IPMSM によって生成される総電磁トルクは 式 40 によって表すことができ、生成されるトルクは 2 つの異なる項で構成さ

れます。最初の項は、トルク電流 iq と永久磁石の間で発生する相互応答トルクに対応します。ψm (39)

一方、2 番目の項は d 軸と q 軸のインダクタンスの違いによるリラクタンス トルクに対応します。

Te = 32p  ψmiq+ Ld− Lq idiq (40)

ほとんどのアプリケーションでは IPMSM ドライブに速度とトルクの制約があり、これは主にインバータまたはモーターの定

格電流と、使用可能な DC リンク電圧の制限によるものです。これらの制約は、数式 式 41 と 式 42 で表すことができま

す。

Ia = id2+ iq2 ≤ Imax (41)

Va = vd2+ vq2 ≤ Vmax (42)
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ここで、Vmax および Imax は、インバータまたはモーターの最大許容電圧および電流です。 2 レベル 3 相電圧源インバ

ータ (VSI) によって駆動される機械では、達成可能な最大位相電圧は DC リンク電圧と PWM 方式によって制限されま

す。空間ベクトル変調 (SVPWM) を採用する場合、最大電圧は 式 43 に示す値に制限されます。

vd2+ vq2 ≤ vmax = vdc3 (43)

固定子抵抗 Rs は通常、高速動作時は無視できる程度で、定常状態では電流の微分はゼロであるため、式 44 は以下の

ようになります。

Ld2 id+ ψpmLd 2+ Lq2iq2  ≤ Vmaxωm (44)

式 41 の電流制限により、d-q 平面で半径 Imax の円が生成され、加速すると 式 43 の電圧制限によって半径 Vmax が減

少する楕円が生成されます。 結果として得られる d-q 平面の電流ベクトルは、電流と電圧の制約に同時に従うように制御

されなければなりません。これらの制約に従って、IPMSM の動作領域は、図 3-13 に示すように 3 つに分けられます。

І  П Ш

Constant 
Torque

Constant 
Power

Constant 
Voltage

ωb ωc ωm 

Te 

図 3-13. IPMSM 制御の動作領域

1. 定トルク領域：この動作領域では、MTPA を実装して最大トルクの生成を維持することができます。

2. 定電力領域：弱め界磁制御の適用が必要であり、トルク容量は電流制約に達すると低下します。

3. 定電圧領域：この動作領域では、深い弱め界磁制御により固定子電圧が一定に保たれ、トルク生成が最大になりま
す。

定トルク領域では、式 40 に基づき、IPMSM の総トルクには、磁束結合による電磁トルクと、Ld および Lq 間の突極性から

のリラクタンス トルクが含まれます。 電磁トルクは q 軸の電流 iq に比例し、リラクタンス トルクは d 軸の電流 id、q 軸の電

流 iq、および Ld と Lq の差の乗算に比例します。 

SPM モーターの通常のベクトル制御システムでは、非弱め界磁モードで指令された id をゼロに設定することにより、電磁

トルクのみを利用します。ただし、IPMSM はモーターのリラクタンス トルクを利用するため、d-軸電流も制御する必要があ

ります。MTPA 制御の目的は、リファレンス電流 id と iq を計算し、生成される電磁トルクとリラクタンス トルク間の比を最大

化することです。 id と iq の関係と固定子電流 Is のベクトル和を以下の式に示します。 

Is = id2+ iq2 (45)Id = Iscos β (46)Iq = Issin β (47)

β は同期 (d-q) リファレンス フレームにおける固定子の電流角度です。式 40 は 式 48 と表すことができます。Is は id と 

iq に代入します。 

式 48 は、モーター トルクが固定子電流ベクトルの角度に依存することを示しています。
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Te = 32pIssin β  ψm+ Ld− Lq Iscos β (48)

最大効率点は、モーターのトルク差がゼロのときに計算できます。MTPA 点は、この差分dTedβ (49)

が、式 50 で示されるように、ゼロのときに見つけることができます。dTedβ = 32p  ψmIscos β+ Ld− Lq Is2cos 2β = 0  (50)

この式に従うと、MTPA 制御の電流角度は、式 51 のように導くことができます。

βmtpa = cos−1 −ψm+ ψm2 + 8 × Ld − Lq 2 × Is24 × Ld − Lq × Is (51)

したがって、実際の d 軸と q 軸のリファレンス電流は、MTPA 制御の電流角度を用いて、式 52 と 式 53 で表すことがで

きます。Id = Is × cos βmtpa (52)Iq = Is × sin βmtpa (53)

ただし、式 51 に示すように、MTPA 制御の角度 βmtpa は、d 軸と q 軸のインダクタンスに関係します。つまり、変動するイ

ンダクタンスの影響によって、最適な MTPA 点を見つけ出すことができなくなるということです。モーター駆動の効率を高

めるには、d 軸と q 軸のインダクタンスをオンラインで推定する必要がありますが、Ld と Lq パラメータはオンラインでは簡

単に測定されず、飽和効果の影響を受けます。 堅牢なルック アップ テーブル (LUT) 方式により、電気的パラメータが変

動しても制御可能な状態を維持します。通常、数学モデルの簡略化のために、d-軸と q-軸のインダクタンス間のカップリ

ング効果は無視することができます。したがって、Ld は id のみに応じて変化し、Lq は iq のみに応じて変化すると仮定して

います。 その結果、d 軸および q 軸のインダクタンスは、式 54 と 式 55 に示すように、それぞれ d-q 電流の関数としてモ

デル化できます。Ld = f1 id,  iq = f1 id (54)Lq = f2 iq,  id = f2 iq (55)

式 51 を簡略化することで、ISR の計算負担を軽減しています。モーター パラメータに基づく定数 Kmtpa は、式 56 の代

わりとして表されます。ここで、Kmtpa は、更新された Ld および Lq を使用して、バックグラウンド ループで計算されます。 

Kmtpa = ψm4 × Lq − Ld = 0 . 25 × ψmLq − Ld (56)

βmtpa = cos−1 Kmtpa÷ Is− Kmtpa÷ Is 2+ 0 . 5 (57)

2 番目の中間変数 Gmtpa (式 58 に記載) が、計算をさらに簡単にするために定義されます。Gmtpa (MTPA 制御の角度) 
を使用すると、βmtpa は 式 59 のように計算できます。 これら 2 つの計算を ISR で行い、実際の電流角度 βmtpa を達成し

ます。Gmtpa = Kmtpa÷ Is (58)

βmtpa = cos−1 Gmtpa− Gmtpa2 + 0 . 5 (59)
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いずれの場合も、直軸の電流 id に作用することで磁束を弱め、実現可能な速度範囲を拡大することができます。この定

電力動作領域に入ったことにより、定電力領域と定電圧領域で使用される MTPA 制御の代わりに、弱め界磁制御が選択

されます。インバータの最大電圧が制限されるため、永久磁石の磁場とモーター速度にほぼ比例する逆起電力がインバ

ータの最大出力電圧を上回るような速度領域では、PMSM モーターは動作できません。PM モーターでは、磁束を直接

制御することはできません。ただし、d 軸電機子反作用による減磁効果により、負の id を加えることでエア ギャップ フラッ

クスを弱めることができます。電圧と電流の制約を考慮すると、電機子電流と端子電圧は 式 41 と 式 42 のように制限され

ます。インバータの入力電圧 (DC リンク電圧) の変動により、モーターの最大出力が制限されます。さらに、モーターの最

大基本電圧も使用する PWM 方式によって異なります。式 44 では、IPMSM には 2 つの要素があります。1 つは永久磁

石の値で、もう 1 つはインダクタンスとフラックスの電流によって作られています。

図 3-14 に、弱め界磁を実装するために使用される代表的な制御構造を示します。

βfw は弱め界磁 (FW) PI コントローラの出力で、基準 id と iq を生成します。 電圧振幅が限界に達する前は、FW の PI コ
ントローラの入力は常に正であるため、出力は常に 0 で飽和しています。
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図 3-14. 弱め界磁と最大トルク / 電流制御のブロック図

モーター駆動 FOC システムには、MTPA 制御と弱め界磁制御の 2 つの制御モジュールがあります。これら 2 つのモジ

ュールは、図 3-15 に示す入力パラメータに基づいてそれぞれ電流角度 βmtpa と βfw を生成します。 

d

q

is_fw

is_mtpa

id_fw

iq_fw

id_mtpa

iq_mtpa

βfw
βmtpa

図 3-15. FW および MTPA 時の IPMSM の電流位相図

スイッチング制御モジュールは、適用できる角度を決定してから、式 46 と 式 47 に示すように基準 id および iq を計算し

ます。 電流角度は、式 60 と 式 61 のように選択されます。β = βfw if βfw > βmtpa (60)β = βmpta if βfw < βmtpa (61)
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図 3-16 に、このリファレンス デザインにおける、弱め界磁制御 (FWC) と最大トルク / 電流 (MTPA) を備えた eSMO を
使用した、PMSM のセンサレス FOC の全体ブロック図を示します。
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図 3-16. FWC と MTPA を備えた eSMO を使用した PMSM のセンサレス FOC

3.1.5.2 フライング スタート

フライング スタート (FS) は、ドライブが回転しているモーターの速度と方向を判定し、その速度と方向で出力電圧と周波

数を開始する機能です。フライング スタートなしの場合は、ドライブは 0V および速度ゼロで出力を開始し、指示された速

度まで上昇しようと試みます。負荷の慣性または回転方向によりモーターに大きなトルクを発生させる必要がある場合、過
電流が発生し、ドライブに過電流トリップが発生することがあります。フライング スタートでこれらの問題は解消できます。

フライング スタートとは、ゼロ以外の任意の速度で制御を開始できる機能であり、エアコン アプリケーションのファン駆動で

重要な機能です。

モーターを通常モードで起動すると、制御は最初に周波数 0Hz を適用し、目的の周波数まで上昇します。モーターがす

でにゼロ以外の周波数で回転している状態で、このモードでドライブを起動すると、大電流が発生します。電流リミッタが
迅速に応答できない場合、過電流トリップが発生する可能性があります。電流リミッタが過電流トリップを防止するのに十
分な速さであっても、同期には許容できないほどの時間がかかり、モーターが目的の周波数に達するまで時間がかかるこ
とがあります。それに加えて、より大きな機械的ストレスがアプリケーションにかかります。

フライング スタート モードでは、スタート コマンドに対するドライブの応答は、モーターの速度 (周波数と位相) および電圧

に同期することになります。その後、モーターは指令された周波数まで加速します。このプロセスにより過電流トリップが防
止され、モーターが指令された周波数に達するまでの時間が大幅に短縮されます。ドライブは回転速度でモーターと同期
し、適切な速度まで上昇するため、機械的ストレスはほとんどありません。

フライング スタート機能には、回転子速度を検索するアルゴリズムが実装されています。このアルゴリズムは、モーターに

印加される励磁電流に対応するモーター電圧を検索します。

モーターが回転しているときは、BEMF 電圧から速度と位置の情報を推定できます。固定子電圧を測定するため、インバ

ータを切り替えることで速度と位置を簡単に取得できます。モーターにゼロ トルク電流を印加し、生成された電流と固定子

電圧を測定した後、FOC モジュールはこれらの信号を使用して回転子の位置と速度を推定します。
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フライング スタートを備えた FOC のブロック図を 図 3-17 に示します。フライング スタート モジュールは、速度閉ループ

制御をイネーブルまたはディスエーブルにするフラグを出力します。フライング スタートの動作中は、ゼロ リファレンス トル

ク電流が設定され、速度 PI コントローラ出力はディスエーブルになります。

Speed PI Iq 

PI

Id

PI

Flying Start  

speed_ref

Iq_ref = 0

Enable SpeedCtrl

User Id_ref

User Iq_ref

Enable FS

Vd

Vqspeed_est

Estimator

PARK

�

�

Iα

Iβ

Iα

Iβ

VαVβ Vbus

図 3-17. フライング スタート制御のブロック図

図 3-18 に、このリファレンス デザインにおける、フライング スタートを用いた eSMO による、PMSM のセンサレス FOC 
の全体ブロック図を示します。
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図 3-18. フライング スタートを用いた eSMO による PMSM のセンサレス FOC

図 3-19 に示すように、モジュール ルーチンは速度閉ループ制御をディスエーブルにし、リファレンス Iq をゼロに設定し

て、モーター始動時に FOC モジュールをイネーブルにします。位相電流と位相電圧を測定した後、ルーチンは FOC を
実行し、実際のモーター速度を推定することができます。プログラムは、フライング スタートが完了した後、速度閉ループ

制御を再度イネーブルにし、速度リファレンス値を設定します。
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4 ハードウェア、ソフトウェア、テスト要件、テスト結果

4.1 ハードウェア要件

表 4-1 に、ユニバーサル モーター制御プロジェクトでサポートされている最新の評価キットを示します。

表 4-1. ユニバーサル モーター制御でサポートされているモーター ドライブ評価キット

モーター ドライブ評価ボード
テキサス・インスツルメンツの 

MCU 評価ボード
電流センシング トポロ

ジ
回転子位置センシン

グ方式 テスト対象モーター部品番号 説明

BOOSTXL-3PHGAN
INV

12-60V、3.5A 3 相 

GaN インバータ

LP-AM263 3 つのシャント ベース

のインライン モーター

位相電流センシング

eSMO オブザーバ ベ
ースのセンサレス 
FOC
QEP エンコーダ ベー

スのセンサ付き FOC
ホール センサ ベース

のセンサ付き FOC

LVSERVOMTR (エン

コーダとホール センサ

を内蔵)

TMDSHVMTRINSPI
N (1) 

400V、10A 3 相イ

ンバータ

TMDSCNCD263 と 
TMDSADAP180TO100

3 つのローサイド電流

シャント

eSMO オブザーバ ベ
ースのセンサレス 
FOC
QEP エンコーダ ベー

スのセンサ付き FOC

HVPMSMMTR (エン

コーダを内蔵) 

(1) LVSERVOMTR のような低電圧モーターを高電圧キットで動作させる場合、J1、J2、J3、J4 にジャンパを実装し、820k の抵抗をバイパスして位

相電圧と DC バス電圧をセンシングする必要があります。また、以下のコードに示すように、user_mtr1.h にパラメーターを設定します。高電圧キ

ットでは、大電流で低インダクタンスの低電圧モーターを動作させないことを推奨します。

// Bypass the 820k resistor for low voltage motor on this kit
#define LV_JUMPER_EN            // Bypass the 820k resistor

プロジェクトがエンコーダまたはホール ベースのセンサ付き FOC を使用するように設定されている場合は、物理的な接

続が正しい順序で接続されていることを確認します。モーター、エンコーダ、またはホール ワイヤの接続順序が誤ってい

ると、プロジェクトが正しく機能せず、モーターが回転できない可能性があります。モーター位相のワイヤについては、イン
バータ ボード上でモーター位相が正しい位相に接続されていることを確認します。テキサス・インスツルメンツのモーター

制御リファレンス キットに付属のモーターの場合、表 4-2 に示すように、正しい位相接続が提供されています。

エンコーダの場合は A が A、B が B、I が I に接続されていること、ホール センサの場合は A が A、B が B 、C が C に
接続されていることを確認します。多くの場合、+5V DC およびグランド接続も必要になります。表 4-2 に示されているもの

とは異なるホール センサまたはエンコーダを使用している場合、使用しているホール センサまたはエンコーダのユーザー 

マニュアルを参照して、ワイヤが正しく接続されていることを確認してください。

ENC モジュールの設定と構成では、エンコーダの 1 回転あたりのスロット数が示されていることを確認してください。これ

により、ENC モジュールはエンコーダ信号を正しく角度に変換できます。user_mtr1.h ファイルで定義されている 

USER_MOTOR1_NUM_ENC_SLOTS 定数は、使用するエンコーダ用の正しい値に更新する必要があります。この値

が正しくない場合、設定された値に応じて、モーターの回転が高速または低速になります。この値は、直交精度を算出し
た後のカウント数ではなく、エンコーダのスロット数に設定されることに注意してください。

表 4-2. リファレンス キットとモーターのモーター位相、エンコーダ、ホール センサの接続

LVSERVOMTR HVPMSMMTR

モーター位相ライン U BLACK (16AWG) 赤色

V RED (16AWG) 青色 / 黒色

W WHITE (16AWG) 白色

エンコーダ GND BLACK (J4-1) 黒色

+5V RED (J4-2) 赤色

I BROWN (J4-3) 黄色

B ORANGE (J4-4) 緑色

A BLUE (J4-1) 青色
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表 4-2. リファレンス キットとモーターのモーター位相、エンコーダ、ホール センサの接続 (続き)
LVSERVOMTR HVPMSMMTR

ホール センサ GND BLACK (J10-1) ホール センサ ベースのセンサ付き 

FOC はサポートしていません+5V RED (J10-2)

A GRAY-WHITE (J10-3)

B GREEN-WHITE (J10-4)

C GREEN (J10-5)

テキサス・インスツルメンツのリアルタイム制御マイクロコントローラ (MCU) を使用して、モーター制御の実装を開始しま

す。

• ステップ 1：表 4-1 に示すように、目的のモーター ドライブ評価ボード、テキサス・インスツルメンツの MCU 評価ボー

ド、モータを注文します。
• ステップ 2：MOTOR-CONTROL-SDK-AM263X の最新バージョンをダウンロードします。

• ステップ 3：Code Composer Studio IDE の最新バージョンをダウンロードします。

• ステップ 4：技術資料の指示に従ってハードウェアを設定し、以降のセクションで説明するプロジェクトを実行します。

• ステップ 5：設計に関する質問への回答については、既存の回答を検索するか、 TI C2000 E2E 設計サポート フォー

ラム を使用して自分で質問できます。
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4.2 ソフトウェア要件

1. Code Composer Studio (CCS) 統合開発環境 (IDE) ツール フォルダから Code Composer Studio をダウンロード

してインストールします。バージョン 12.6 またはそれ以降をお勧めします。CCS のインストールと実装の詳細につい

ては、『CCS ユーザー ガイド』を参照してください。

2. テキサス・インスツルメンツが提供するリンクから MOTOR-CONTROL-SDK-AM263X ソフトウェア パッケージをダウ

ンロードしてインストールし、この Motor Control SDK ソフトウェアをデフォルト フォルダにインストールします。

MOTOR-CONTROL-SDK-AM263X は次の 2 つのいずれかの方法でインストールできます。

a. MOTOR-CONTROL-SDK-AM263X ダウンロード フォルダからソフトウェアをダウンロードします。

b. CCS にアクセスし、[View] → [Resource Explorer] に進みます。TI Resource Explorer で、[Arm®-based 
microcontrollers] → [MOTOR CONTROL SDK for AM263x] に進み、[Install] ボタンをクリックします。

3. インストールが完了したら、CCS を閉じ、プロジェクトをインポートするための新しいワークスペースを作成します。以

降のセクションで説明するように、異なるインクリメント ビルドでこのプロジェクトをビルドして実行する手順に従います。

4.2.1 プロジェクトのインポートと構成

このプロジェクトは、テキサス・インスツルメンツの EVM モーター ドライバ キットをサポートし、AM263x MCU デバイスと一

緒に使用できるユニバーサル モーター制御設計です。プロジェクトのビルド構成とプロパティを設定することで、テキサ

ス・インスツルメンツの異なる EVM キットを実行できます。以降のセクションでは、LP-AM263 を 

BOOSTXL-3PHGANINV ラボと組み合わせて使用し、このキットでサンプル ラボをインポートして実行する方法を示しま

す。

1. [Project] ➔ [Import CCS Project...] をクリックして CCS 内にプロジェクトをインポートし、[Browse...] をクリックして、

a. <install_location>\examples\ 検索ディレクトリを選択し、universal_motorcontrol_lab フォルダを選

択します。
2. プロジェクトは、2 つのモーター ドライバ キットで実行するように構成できます。図 4-1 に示すように、インポートしたプ

ロジェクト名を右クリックし、適切なビルド構成 (3phGaN_3SC など) を選択することで、これらのキットのいずれかを選

択できます。
3. インポートしたプロジェクト名を右クリックしてプロジェクトのサポート機能を選択するようにプロジェクトを構成し、図 4-2 

に示すように、[Properties] コマンドをクリックしてプロジェクトの事前定義シンボルを設定します。

a. 事前定義シンボルは、名前の _N を削除または追加することで有効または無効になります。たとえば、弱め界磁

制御をイネーブルにするには、MOTOR1_FWC_N の _N を削除して MOTOR1_FWC に変更し、弱め界磁制

御をディセーブルにするには、MOTOR1_FWC シンボル名を MOTOR1_FWC_N に変更します。

b. 上記のように関連する事前定義シンボルをイネーブルにして、モーターとハードウェア ボードに基づいて、適切

にサポートされるモーター制御アルゴリズムを選択します。サポートされるアルゴリズムと関連するモーター マトリ

クスを 表 4-3 に示します。

c. 図 4-2 に示すように、事前定義シンボルをイネーブルにして、適切にサポートされる機能を選択します。

4. 図 4-4 に示すように、ファイル名を右クリックし、ポップアップ メニューで [Set as Active Target Configuration] およ

び [Set as Default Target Configuration] を選択して、適切なターゲット構成ファイル (.ccxml) を選択します。

a. AM263_LP.ccxml は、LP-AM263 ベースのハードウェア キット向けです。

b. AM263_CC.ccxml は、TMDSCNCD263 ベースのハードウェア キット向けです。

5. user_mtr1.h ファイルと user_common.h ファイルで適切なモーター モデルを選択または定義します。 これらのファ

イルは、Project Explorer ウィンドウにある src_board フォルダの下にあります。テスト対象のモーターに対応する 

#define のコメントを解除し、残りの #define モーターがコメントアウトされたままであることを確認します。コード内のモ

ーター パラメータが、接続されているモーターの仕様と一致していることを確認してください。

6. セクション 4.3 に示すように、ハードウェア キットを設定し、モーター、エンコーダ、ホール センサをキットに接続しま

す。
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Right-click on project name with 

CCS. Click “Build Configurations” 

to select the right build 

configuration to set it active

図 4-1. CCS 内で適切なビルド構成を選択する

Select one of the algorithm for 

the hardware board according 

the table

Enables the supporting 

additional functions

Enables the debugging 

functions

Right-click on project name 

within CCS. Click “Properties” 

on pop-up menu, navigate to 

“Predefined Symbols”

Select external command and 

speed input mode

図 4-2. [Project Properties] で目的の事前定義シンボルを選択する
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表 4-3. ユニバーサル モーター制御においてサポートされるアルゴリズム、機能、モーター マトリクス

アルゴリズムまたは機能 事前定義シンボル LaunchPad controlCARD
BOOSTXL-3PHGANINV TMDSHVMTRINSPIN

eSMO ベースのセンサレス FOC MOTOR1_ESMO ✔、LVSERVOMTR ✔、HVPMSMMTR

QEP エンコーダ ベースのセンサ付

き FOC
MOTOR1_ENC ✔, LVSERVOMTR ✔、HVPMSMMTR

ホール センサ ベースのセンサ付き 
FOC

MOTOR1_HALL
HALL_CAL

✔、LVSERVOMTR ✖

グラフ ツールによるデータログ DATALOG_EN ✔ ✔

PWMDAC EPWMDAC_MODE ✖ ✔

SFRA ツール SFRA_ENABLE ✔ ✔

グラフ ツールによるステップ応答 STEP_RP_EN ✔ ✔

4.2.2 プロジェクト構造

プロジェクトの一般構造を図 4-3 に示します。デバイス ペリフェラルの構成は、TI SysConfig に基づいています。リファレ

ンス デザイン ソフトウェアをカスタム ボードや別のデバイスに移行する場合は、hal.c ファイルと hal.h ファイルのコードと

定義、user_mtr1.h ファイルのパラメータを変更することだけが必要です。 

AM26x MCU

Observer Library

eSMO
Encoder

Hall

Board and Motor 
specific 

parameters
user_mtr1.c 
 user_mtr1.h

Board specific drivers 
configuration
hal.c, hal.h

Motor drive control specific files
motor_common.c, motor1_drive.c
motor_common.h, motor1_drive.h

Build level setting
sys_settings.h

FOC Library

PI, PID
CLARKE

PARK/I-PARK
SVGEN

Trajectory

System solution specific files
sys_main.c
sys_main.h

SysConfig
Generated 

Files

AM26x
MCU

図 4-3. プロジェクト構造の概要

プロジェクトが CCS にインポートされると、図 4-4 に示すように、CCS 内に Project Explorer が表示されます。

transforms フォルダには、パーク、クラーク、逆パーク、SVGEN など、モーター ドライブ ISR の一部で、特定のデバイス

やボードに依存しない標準的な FOC モジュールが含まれています。

libraries フォルダには、推定ライブラリ、および特定のデバイスやボードに固有ではないその他のライブラリが含まれてい

ます。

src_control フォルダには、割り込みサービス ルーチンおよびバックグラウンド タスク内でモーター制御コア アルゴリズム

関数を呼び出すモーター ドライブ制御ファイルが含まれています。

src_sys フォルダ には、特定のデバイスやボードに依存しない、システム制御のために予約されたいくつかのファイルが

含まれています。システム制御や通信などのコードを追加できます。
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ボード固有のファイルとモーター固有のファイルは、src_board フォルダにあります。これらのファイルは、デザインを実行

するデバイス固有のドライバで構成されています。独自のボード用にプロジェクトを移行する場合、または別のデバイスに
プロジェクトを移行する場合、当該ボードのデバイス ペリフェラルの使用方法に基づいて、hal.c ファイル、hal.h ファイル、

xxx.syscfg ファイル、user_mtr1.h ファイルを変更することだけが必要です。 

Project Name [Build Configuration]

Generated files with SysConfig

System main file

Target Configuration for debugger 

connection, select one to be active 

according to hardware board

Hardware board drivers for the solution

Board and motor parameters definition files

Motor drive common functions files

CAN command file

Motor drive and math libraries

Motor drive control specific files

PWMDAC driver file

Save variables list to be imported into the 

Expressions window

Header files path for different components 

in the project

図 4-4. ユニバーサル モーター制御プロジェクトの Project Explorer ビュー
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4.2.3 ラボ ソフトウェアの概要

図 4-5 に、ファームウェアのプロジェクト ソフトウェアのフローチャートを示します。これには、リアルタイム モーター制御用

の ISR と、バックグラウンド ループで更新されるモーター制御パラメータ用のメイン ループがそれぞれ 1 つ含まれていま

す。ISR は、ADC の変換終了 (EOC) によってトリガされます。

System initialization (DPL, CLOCK, 

Pinmux, peripherals)

Board initialization

int main

Initialize motor control parameters

Setup Fault Protection for motors

Setup Interrupts for motors control

Update motor control parameters

Main Background Loop

Save contexts and clear int flags

C – ISR

(Motor Control)

Read ADC Result, current/voltage 

calculation and clark transform

Run eSMO estimators or Encoder

Run speed trajectory control

Restore Context

Return

Motor  Control Loop in ISR

ADC offset calibration for motors

Run motor control

Run speed loop compensator

Run FWC and MTPA

Id and Iq reference calculation

Run  I-Park, SVGEN and PWM Modulator

Run Id and Iq loop compensator

Motor Control ISR

図 4-5. プロジェクト ソフトウェアのフローチャート

システムの立ち上げとデザインを簡素化するため、ソフトウェアは 4 つのインクリメンタル ビルドで構成されており、これに

よりボードやソフトウェアに慣れ、理解することが容易になります。また、このアプローチは、基板のデバッグやテストにも適
しています。
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表 4-4 に、このプロジェクトで使用するフレームワーク モジュールを示します。

表 4-4. プロジェクトにおけるモーター制御モジュールの使用

モジュール名 説明 アルゴリズム

ANGLE_GEN_run 開ループ動作用回転子角度ジェネレータ eSMO、ENC、HALL

CLARKE_run 電流または電圧のクラーク変換 eSMO、ENC、HALL

collectRMSData、calculateRMSData サンプリング値を収集し、位相電流と位相電圧の 
RMS 値を計算する

eSMO、ENC、HALL

DATALOG_update グラフ ツールで表示するためにリアルタイム値を

保存する

すべてのアルゴリズム

ENC_run エンコーダに基づいて回転子角度を計算する ENC

ESMO_run センサレス FOC 用の拡張スライディング モード 

オブザーバ (eSMO)
eSMO

HAL_readMtr1ADCData ADC 変換値を浮動小数点フォーマットで返す すべてのアルゴリズム

HAL_writePWMDACData ソフトウェア変数を PWM 信号に変換する すべてのアルゴリズム

HAL_writePWMData モーター用 PWM ドライブ すべてのアルゴリズム

HALL_run 回転子の角度と速度をホール センサに基づいて

計算する

HALL

IPARK_run 逆パーク変換 eSMO、ENC、HALL

PARK_run パーク変換 eSMO、ENC、HALL

PI_run 電流および速度の PI レギュレータ すべてのアルゴリズム

PI_run_series PI コントローラを連続して実行する SFRA、MPTA

SPDCALC_run エンコーダ信号からの角度に基づく速度の測定 ENC

SPDFR_RUN オブザーバからの角度に基づく速度の測定 eSMO

SVGEN_runMin 直交制御による空間ベクトル PWM eSMO、ENC、HALL

TRAJ_run 速度リファレンス設定軌道 すべてのアルゴリズム

VS_FREQ_run レベル 2 で Vd と Vq を計算するために、v/f プ
ロファイルでベクトル電圧を生成する。

特定のモーターに基づいて手動で行うことが可

能。

eSMO、ENC、HALL
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各インクリメンタル システム ビルドでテストされたモジュールを 表 4-5 にまとめています。

表 4-5. 各インクリメンタル ビルドで使用されるモーター制御モジュール

ソフトウェア モジュール DMC_LEVEL_1 DMC_LEVEL_2 DMC_LEVEL_3 DMC_LEVEL_4

50% PWM デューティ、

ADC オフセット較正、PWM 
出力、位相シフトの検証

モーターの電流と電圧のセ
ンシング信号を検証する開

ループ制御

ボード上の電流センシング
と、PID による電流制御を検

証する閉電流ループ

エスティメータ / オブザーバ

による閉ループ動作

HAL_readMtr1ADCData √√ ✓ ✓ ✓
HAL_writePWMData √√ ✓ ✓ ✓
ANGLE_GEN_run √√ ✓ √(eSMO、ENC、HALL)*

VS_FREQ_run √√

CLARKE_run ✓ ✓ ✓
TRAJ_run √√ ✓ √√

ESMO_run √(eSMO)* √(eSMO)* √√ (eSMO)*

SPDFR_RUN √(eSMO)* √(eSMO)* √√ (eSMO)*

ENC_run √(ENC)* √(ENC)* √√(ENC)*

SPDCALC_run √(ENC)* √(ENC)* √√(ENC)*

HALL_run √(HALL)* √(HALL)* √√(HALL)*

PARK_run ✓ ✓ ✓
PI_run (Id) √√ ✓
PI_run (Iq) √√ ✓

PI_run (速度) √√

IPARK_run √√ ✓ ✓
SVGEN_runMin √√ ✓ ✓
HAL_writePWMDACData √** √** √**

DATALOG_update ✓ ✓ ✓

1. √ は、このモジュールが使用されていることを意味します。√√ は、このモジュールはテスト中であることを意味します。

2. √ (eSMO)* は、このモジュールが eSMO によってのみ使用されることを意味します。√ (ENC)* は、このモジュールが 

ENC によってのみ使用されることを意味します。√ (HALL)* は、このモジュールが HALL によってのみ使用されること

を意味します。
3. √**は、表 4-1 に示すように、このモジュールが一部のハードウェアキットでサポートされていることを意味します。

ユニバーサル プロジェクトでは、モーター制御用に FOC アルゴリズムのいずれかを個別に使用することも、eSMO アル

ゴリズムとエンコーダ FOC アルゴリズムの内の 2 つを同時に使用することもできます。プロジェクトに 2 つのアルゴリズム

が実装されていれば、使用中のエスティメータをその場でスムーズに切り替えることができます。

ハードウェア、ソフトウェア、テスト要件、テスト結果 www.ti.com/ja-jp

30 AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


4.3 テスト設定

このセクションでは、モーター ドライバ評価ボードをテキサス・インスツルメンツの開発ツールと組み合わせた場合のモータ

ー制御用ハードウェア ボードの設定方法について説明します。以降のセクションでは、異なるモーター ドライバ評価ボー

ドでの詳細な操作手順を示します。

4.3.1 LP-AM263 の設定

LP-AM263 は、テキサス・インスツルメンツの Arm®ベース リアルタイム マイクロコントローラ向けの低コスト開発ボードで

す。この LaunchPad キットには開発用のピンが追加されており、2 つの BoosterPack™ プラグイン モジュールの接続を

サポートしています。

• LP-AM263 の詳細については、『LP-AM263 LaunchPad ユーザー ガイド』を参照してください。

• LP-AM263 のブート スイッチが 図 4-6 に示すように設定されていることを確認してください。

– QSPI_D0 (SOP0) の場合、スイッチを左側 (ロジック High) にします。

– QSPI_D1 (SOP1) の場合、スイッチを左側 (ロジック High) にします。

– SPI0_CLK_pad (SOP2) の場合、スイッチを右側 (ロジック Low) にします。

– SPI0_D0_pad (SOP3) の場合、スイッチを左側 (ロジック High) にします。

• CMPSS が正常に動作するように、LP-AM263 の DAC VREF スイッチ (S1) が AM263x オンダイ LDO に設定され

ていることを確認してください。

図 4-6. LP-AM263 LaunchPad™ ボードの概要とスイッチの設定

4.3.2 BOOSTXL-3PHGANINV の設定

BOOSTXL-3PHGANINV 評価ボードは、サーボ ドライブなどの高精度なドライブ制御のための高精度インライン シャント 

ベース位相電流センシング機能を備えた 48V/10A の 3 相 GaN インバータを搭載しています。また、この評価ボードは

個別の DC バスと 3 相電圧センシング機能も備えているため、センサレス FOC アルゴリズムを使用することを想定したテ

キサス・インスツルメンツの LaunchPad™ 開発キットを使用して、BLDC/PMSM 制御を行うことができます。

• ハードウェア ファイルなどの詳細については、TI.com の BOOSTXL-3PHGANINV ページを参照してください。

• BOOSTXL-3PHGANINV の詳細については、対応する『ユーザー ガイド』を参照してください。

• 次の項目が説明のとおりに完了していることを確認し、図 4-7 に示すように、BOOSTXL-3PHGANINV を LP-AM263 
の J6/J8 および J5/J7 に接続します。

• 図 4-7 と 表 4-2 に示すように、モーター、エンコーダ、ホール センサを BOOSTXL-3PHGANINV および LP-AM263 
に接続します。

• バッテリまたは DC 電圧源から 24V の電源電圧を電圧電源ピンに接続します。セクション 4.4 の操作手順に従って、

電源をオンにします。
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図 4-7. LP-AM263 と BOOSTXL-3PHGANINV の接続

4.3.3 TMDSCNCD263 の設定

TMDSCNCD263 は、テキサス・インスツルメンツの Arm® ベース MCU シリーズの AM26x デバイスに適した評価 / 開発

ボードです。TMDSCNCD263 は HSEC180 (180 ピンの高速エッジ コネクタ) 搭載しており、TMDSADAP180TO100 
アダプタで既存の 100 ピン DIMM ベースの TMDSHVMTRINSPIN にで使用できます。

• TMDSCNCD263 の詳細については、『AM263x Sitara 制御カード ハードウェア ユーザー ガイド』を参照してくださ

い。
• TMDSCNCD263 のブート スイッチが、図 4-8 に示すように設定されていることを確認してください。

– SW3.1、SW3.2、SW3.4 は、スイッチを LEFT に、クワッド読み取り UART フォールバック モードでオンカード 

XDS110 エミュレータを使用する場合は SW3.2 を RIGHT にしてください。

• TMDSCNCD263 の DAC VREF スイッチ (SW6) を UP に切り替えて、AM263x オンダイ LDO のリファレンス電圧を

適切な CMPSS 動作に設定してください。
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図 4-8. TMDSCNCD263 controlCARD とスイッチの設定

4.3.4 TMDSADAP180TO100 の設定

TMDSADAP180TO100 アダプタを使用すると、既存の 100 ピン DIMM ベースの評価ツールとともに、180 ピンのテキ

サス・インスツルメンツの controlCARD を使用できます。TMDSCNCD263 controlCARD を TMDSHVMTRINSPIN で
使用するには TMDSADAP180TO100 が必要です。

• ハードウェア ファイルは、 C2000Ware の 

<install_location>\boards\controlCARDs\TMDSADAP180TO100 フォルダにあります。

• スイッチ TMDSADAP180TO100 が、図 4-9 に示すように設定されていることを確認してください。

– S1 スイッチ、S2 スイッチ、S3 スイッチは RIGHT に、S4 スイッチは LEFT に配置する必要があります。

Up

Right

S1  ��  cCard-30&33 

Selection Switch

(On Right)

S2  ��  cCard-80&83 

Selection Switch

(On Right)

S3  ��  cCard-31&84 

Selection Switch

(On Right)

S4  ��  cCard-81&34 

Selection Switch

(On Left)

図 4-9. TMDSADAP180TO100 のアダプタとスイッチの設定
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4.3.5 TMDSHVMTRINSPIN の設定

警告

• この EVM はラボ環境のみで動作するものであり、テキサス・インスツルメンツでは一般消費者の使用に

適した最終製品とはみなしておりません。
• この EVM は、高電圧の電気機械部品、システム、およびサブシステムの取り扱いに関連するリスクを熟

知した有資格のエンジニアや技術者のみが使用してください。
• 取り扱いが不適切な場合、この EVM は感電、火災、人身傷害をもたらす可能性のある電圧および電流

で動作します。機器は注意深く使用して、人身傷害や物的損害を避けるために適切な安全対策が講じら
れる必要があります。

• 高電圧が印加されているため、EVM の電子機器を使用するときは常に注意してください。DC バス コン

デンサは、主電源を切断した後も長時間充電されたままです。
• この EVM は、AC 主電源 / 壁面コンセントから電力供給を受けることができ、壁面コンセントからのライブ 

ラインとニュートラル ラインのみを使用し、保護用のアースは接続されていません (フローティング状態で

す)。電源グランドは保護接地と接続されておらず、すべてのグランド プレーンが同じです。そのため、ス

コープや他のテスト機器をボードに接続する前に、適切な注意を払い、正しい絶縁要件を満たす必要が
あります。接地された機器を EVM に接続するときは、絶縁トランスを使用する必要があります。

• ボード上の電力段は個別に定格されています。ユーザーは、これらの電源ブロックを相互に接続してボ
ードに電力を供給する前に、これらの定格 (たとえば、電圧、電流、電力などのレベル) をよく理解し、準

拠していることを確認する責任があります。電力が供給されているときは、EVM や EVM に接続されてい

る部品に触れないでください。

TMDSHVMTRINSPIN は、DIMM100 controlCARD ベースのマザーボード評価ボードで、AC 誘導 (ACI)、ブラシレス 

DC (BLDC)、永久磁石同期モーター (PMSM) などの最も一般的なタイプの高電圧 3 相モーターの制御を示します。高

電圧モーター制御キットは個別の DC バスと 3 相電圧センシング機能を備えているため、テキサス・インスツルメンツの 

controlCARD™ を使用した BLDC/PMSM 制御向けのこのボードは、センサレス FOC アルゴリズムでの使用に最適で

す。

• ハードウェア ファイルは、 C2000WARE-MOTORCONTROL-SDK の 

<install_location>\solutions\tmdshvmtrinspin\hardware フォルダにあります。

このセクションでは、MotorControl SDK を通じて提供されるソフトウェアで TMDSHVMTRINSPIN を実行するために必

要な手順について説明します。キットは、controlCARD と接続するために、ジャンパとスイッチの設定が正しく配置された

状態で出荷されます。以下に示すように、これらの設定がボード上で有効であることを確認し、図 4-10 に示すように、

TMDSHVMTRINSPIN ボードに TMDSADAP180TO100 アダプタ付き controlCARD を挿入します。
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図 4-10. TMDSHVMTRINSPIN を TMDSADAP180TO100 と一緒に TMDSCNCD263 に接続する

• ボードには何も接続されておらず、電力も供給されていないことを確認してください。

• TMDSADAP180TO100 アダプタ付きの controlCARD がまだ実装されていない場合は、[Main]-J1 controlCARD コ
ネクタに挿入します。

• 図 4-11 に示すように、以下のジャンパ & コネクタの設定が正しく実装されていることを確認してください。

– [Main]-J3、J4、J5、J8 は実装されています。

– [Main]-J9 と [M3]-J5 は、controlCARD をオンボード エミュレーションで使用し、HVKIT の XDS100 をディスエー

ブルにするために実装されていません。
– [Main]-J7 は、ピン 2 とピン 3 (DIMM 100 ソケットから最も離れたピン) の間に実装されています。

– 負荷 > 150W でモーターを動作させる場合、キットに付属の DC ファンが DC ファンジャンパ [Main]-J17 に接続

されていることを確認してください。
• DC バス電源を得るための 2 つのオプションは次のとおりですが、外部 15V DC 電源の使用をお勧めします。

– [Main]-J2 は、外部 15V DC 電源の +15V を使用する場合は実装されません。[M6]-SW1 がオフの位置にあるこ

とを確認し、15V DC 電源を [M6]-JP1 に接続します。

– [Main]-J2 は、補助電源モジュールの +15V 電源を使用する場合、ブリッジと中央ピンの間にジャンパが実装され

ています。
• [M6]-SW1 をオンにします。これで [M6]-LD1 が点灯します。controlCARD の LED も点灯し、controlCARD がボー

ドから電力供給を受けていることを示します。
• 図 4-11 と 表 4-2 に示すように、モーター、エンコーダ、ホール センサをキットに接続します。

• AC 電源または DC 電圧源から電源電圧を電圧電源ピンに接続します。セクション 4.4 で指示があるときは電力が供

給されますが、そうでない場合は切断したままにしてください。

表 4-6 に、ボード上のさまざまな接続を示します。ボード上のこれらの接続の位置は 図 4-11 に示します。

表 4-6. 主なジャンパ、コネクタの説明

[Main]-P1 AC 入力コネクタ (110V～220VAC)

[Main]-TB3 モーターを接続する端子台

www.ti.com/ja-jp ハードウェア、ソフトウェア、テスト要件、テスト結果

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

35

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com/tool/tmdsadap180to100
https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


表 4-6. 主なジャンパ、コネクタの説明 (続き)
[Main]-BS1 AC 整流器からの出力用バナナ ジャック

[Main]-BS2、BS6 GND の接続用バナナ ジャック

[Main]-BS3 PFC 段の入力電圧の接続用バナナ ジャックで、通常は [Main]-BS1 コネクタからの整流 AC 電圧です。

[Main]-BS4 PFC 段からの出力への負荷の接続用バナナ ジャックで、PFC+モーター プロジェクトを使用する場合、PFC 段の

出力は、たとえば [Main]-BS5 のようなインバータ バスの入力に接続されます。

[Main]-BS5 インバータ用 DC バス電圧入力用バナナ ジャック

[Main]-J2 補助電源モジュールの入力電圧選択ジャンパです。

• ジャンパをブリッジの位置に接続すると、補助電源モジュールは AC 整流器ブリッジ出力から電力を供給しま

す。

• ジャンパを PFC の位置に接続すると、補助電源モジュールは PFC 段の出力から電力を供給します。

[Main]-J3、J4、J5 ジャンパ J3、ジャンパ J4、ジャンパ J5 は、それぞれ 15V、5V、3.3V の電力を 15V DC 電源からボードに供給す

るために使用します。

[Main]-J7 J7 は、過電流保護スレッショルド ソースの選択に使用します。

[Main]-J8 J8 は、IPM 過電流保護のイネーブル / ディセーブルに使用します。

[Main]-J9 JTAG TRSTn 切断ジャンパです。このジャンパを実装すると、マイクロコントローラへの JTAG 接続が可能になりま

す。FLASH からブートする場合など、JTAG 接続が必要ない場合は、ジャンパを未実装にする必要があります。

[Main]-J14 PWMDAC 出力：PWM が 1 次ローパス フィルタに接続された結果の電圧出力です。ピン 1 、ピン 2、ピン 3、ピン 

4 はそれぞれローパス フィルタ処理された PWM 出力ピンに接続されており、オシロスコープでシステム変数を観

測します。

[Main]-J16 絶縁型 CAN バス コネクタ

[Main]-J17 IPM ヒートシンクに取り付けられている DC ファン (ボードに同梱) に電力を供給するためのコネクタです。

[Main]-H1 QEP コネクタ：0-5V の QEP センサに接続し、モーターの速度と位置に関する情報を収集します。

CAP / ホール エフェクト センサ コネクタ：0-5V のセンサに接続し、モーターの速度と位置に関する情報を収集しま

す。

[M1]-F1 AC 入力用ヒューズ

[M3]-JP1 オンボード エミュレーション用 USB ケーブル

[M3]-J2 外部 JTAG インターフェイス：このコネクタから JTAG エミュレーション ピンにアクセスできます。外部エミュレーショ

ンが必要な場合は、[M3]-J5 にジャンパを取り付け、エミュレータをボードに接続します。エミュレーション ロジックに

電力を供給するには、引き続き USB コネクタを [M3]-JP1 に接続する必要があります。

[M3]-J5 オンボード エミュレーション ディスエーブル ジャンパ：ここにジャンパを取り付けると、オンボード エミュレータがディ

スエーブルになり、外部インターフェイスにアクセスできるようになります。
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power supply  
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emulation disable jumper  

[Main] J9– JTAG TRSTn 

Option Jumper  
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emulator interface  
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power switch  

[M1] F1 – 

AC input fuse 
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Main] BS3 – 
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Output (750W Max 

Output)  
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図 4-11. TMDSHVMTRINSPIN キットのジャンパとコネクタの図
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4.4 テスト結果

システムは、少しずつテストされ、最終的なシステムが自信を持って操作できるように、複数の段階で検証されます。特定
のビルド オプションを選択するには、sys_settings.h ファイルで DMC_BUILDLEVEL 定義 の値を目的の 

DMC_LEVEL_X オプションに変更します。ビルド オプションを選択した後、プロジェクト名を右クリックし、[Rebuild 
Project] をクリックしてプロジェクトをコンパイルします。

4.4.1 レベル 1 インクリメンタル ビルド

このビルド レベルの目標：

• HAL オブジェクトを使用して、モーター ドライブ ハードウェア用 MCU のペリフェラルを初期化する

• PWM ドライバ モジュール と ADC ドライバ モジュールを検証する

• ADC オフセット検証を確認する

• CCS の操作に慣れる CCS の詳細については、『CCS ユーザー ガイド』を参照してください。

このビルド レベルでは、ボードは固定 PWM デューティ サイクルの開ループ モードで実行されます。デューティ サイクル

は 50% に設定されています。このビルド レベルは、電力段からの帰還値のセンシングと PWM ゲート ドライバの動作を

検証し、ハードウェアに問題がないことを確認します。さらに、入出力電圧センシングの較正もこのビルド レベルで実行で

きます。このプロセス中は、モーターの接続を切り離したままにしておく必要があります。このビルド レベルのソフトウェア 

ブロック図を 図 4-12 に示します。

PWM

Driver

HAL_writePwmData

Ta = 0

HAL_read

Mtr1ADCData

Tb = 0

Tc = 0

Ia
 

Ib
 

Ic
 

Va
 

Vb
 

Vc
 

Vbus
 

ADC

Driver

Three 

Phase 

Inverter

M

図 4-12. ビルドレベル 1 ソフトウェア ブロック図 - オフセット検証

4.4.1.1 プロジェクトのビルドとロード

1. このビルド レベルではモーターをモーター ドライバ ボードに接続する必要がないことを除き、モーター ドライバ ハー

ドウェア ボードと、テキサス・インスツルメンツの LaunchPad または controlCARD を セクション 4.3 に示すように設

定します。
2. USB ケーブルをコンピュータからテキサス・インスツルメンツの LaunchPad または controlCARD のオンボード USB 

コネクタに接続し、MCU に対する絶縁型 JTAG エミュレーションをイネーブルにします。

3. セクション 4.3 に示すように、バス電圧入力端子に適切な電圧を印加して、モーター ドライバ ボードに電力供給しま

す。
4. ユニバーサル モーター制御プロジェクトを CCS にインポートし、セクション 4.2.1 に示すように、正しいビルド構成を

選択します。sys_settings.h ファイルを開き、DMC_BUILDLEVEL を DMC_LEVEL_1 に設定します。これにより、

プロジェクトが最初のインクリメンタル ビルドを実行するように構成されていることを確認できます。

5. Project Explorer ウィンドウで、目的のターゲット構成ファイル名を右クリックし、[Set as Active Target Configuration] 
を選択して、正しいターゲット構成ファイルが Active に設定されていることを確認します。また、ファイル名を右クリック

し、[Set as Default Target Configuration] を選択して、目的のターゲット構成ファイルをデフォルトとして設定するこ
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とをお勧めします。これを行う一つの理由は、どのファイルが Active であるかを示すインジケータが表示されないから

ですが、ファイルがデフォルトに設定されている場合は、Project Explorer ウィンドウでファイル名の横に [Default] イ
ンジケータが表示されます。また、ファイルをデフォルトに設定すると、別の構成ファイルが特に Active に設定されな

い限り、そのファイルがデフォルトとして使用されるようになります。[View] > [Target Configurations] に進んで、

[Target Configurations] ビューでターゲット構成名を右クリックし、[Link to Project] を選択すると、ターゲット構成をワ

ークスペース内のプロジェクトにリンクすることもできます。 
6. プロジェクト名を右クリックし、[Rebuild Project] をクリックします。Console ウィンドウを確認します。プロジェクトのエラ

ーはすべて Console ウィンドウに表示されます。

7. ビルドが正常に完了したら、[Debug] ボタンをクリックするか、[Run] → [Debug] をクリックします。 これで IDE はター

ゲットに自動的に接続され、出力ファイルがデバイスにロードされて、[Debug] パースペクティブに変更されます。右

上隅に CCS Debug アイコンが表示され、[Debug Perspective] ビューに移動したことを示しています。プログラムは 

main() の開始地点で停止する必要があります。

4.4.1.2 デバッグ環境設定ウィンドウ

コードのデバッグ中にローカル変数とグローバル変数を注意深く観察することは、デバッグの標準的なやり方です。CCS 
では、このような変数の観察を行うために、メモリ ビューやウォッチ ビューなど、さまざまな方法を提供しています。さらに、

CCS には時間 (および周波数) ドメインのプロットを作成する機能があります。この機能により、ユーザーはグラフ ツール

を使用して波形を表示できます。グラフ ツールの設定と構成の方法については、セクション 4.5.1 を参照してください。

[Expressions] ウィンドウの設定については、次の手順を参照してください。

1. [Watch] ウィンドウの設定：メニュー バーの [View] → [Expressions] をクリックして、[Expressions] ウォッチ ウィンドウ

を開きます。 [Expressions] ウィンドウで [Add new expression] をクリックし、変数名を入力して、[Enter] キーを押す

と、[Expressions] ウィンドウに変数を追加できます。変数値が表示される数値形式は、変数値が宣言されたときに変

数に関連付けられた数値形式に基づいています。変数を右クリックし、[Number Format] に移動して目的の形式を

選択することで、特定の変数の数値形式を変更できます。

2. 代わりに、[Expressions] ウィンドウ内で右クリックして [Import] をクリックすることで、変数のグループを 

[Expressions] ウィンドウにインポートすることもできます。
<workspace>\universal_motorcontrol_am263x_r5fss0-0_nortos_ti-arm-

clang\src_control\debug\ にあるプロジェクトのディレクトリを参照し、universal_motor_control_level1.txt 
ファイルを選択して [OK] をクリックすると、図 4-13 に示す変数がインポートされます。

注
メイン コードではこの時点で初期化されていない変数もあり、役に立たない値が含まれている可能性がありま

す。
3. 注：構造体変数 motorVars_M1 には、モーター ドライブ制御に関連するほとんどの変数へのリファレンスが含まれて

います。

4. [Expressions Window] タブの右上隅にある [Continuous Refresh] ボタンをクリックし、マイクロコントローラからの定

期的なデータ キャプチャを有効にします。[View Menu] ボタン ([Expressions] ウィンドウの右上隅にある 3 つのドッ

ト) をクリックすることで、[Continuous Refresh Interval] を選択して [Expressions] ウィンドウのリフレッシュ レートを

編集できます。 リフレッシュ間隔が速すぎると、パフォーマンスに影響することがあるので注意してください。
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4.4.1.3 コードの実行

1. [Tools] > [ARM Advanced Features] で [Data Cache Enabled] のチェックを外して、データ キャッシュをディスエ

ーブルにします。
2. [Resume] ボタンを押してコードを実行するか、[Debug] タブで [Run] → [Resume] をクリックします。

3. これでプロジェクトが実行され、グラフおよびウォッチ ウィンドウの値が常に更新されます。

4. ウォッチ ウィンドウで、systemVars.flagEnableSystem が自動的に 1 に設定された後、[Expressions] ウィンドウで

変数 motorVars_M1.flagEnableRunAndIdentify を 1 に設定します。

5. これでプロジェクトが実行され、このプロジェクトを使用している間は、図 4-13 に示すように、グラフと [Expressions] 
ウィンドウの値が常に更新されます。ウィンドウのサイズは、お好みに合わせて変更できます。

6. ウォッチ ビューでは、フォルトが発生していない場合、変数 motorVars_M1.flagRunIdentAndOnLine は 自動的に 

1 に設定されます。[ISRCount] は連続的に増加します。

7. モーター ドライバ ボードの較正オフセットをチェックします。図 4-13 に示すように、モーター位相電流センシング値

のオフセット値は、ADC のスケール電流の半分程度に相当します。

8. グラフ ツールを使用する場合、グラフに表示される変数は、u 相、v 相、w 相の FOC 角度と位相電流です。

9. MotorVars_M1.faultMtrPrev.bit 構造体を展開してチェックし、フォルト フラグが設定されていないことを確認します。

10. オシロスコープを使用して、モーター駆動制御に使用する PWM 出力を測定します。このビルド レベルでは、3 つの 

PWM のデューティ サイクルが 50% に設定され、予測される PWM 出力の波形は、図 4-14 のようになります。PWM 
スイッチング周波数は、user_mtr1.h ファイルの USER_M1_PWM_FREQ_KHz 定義に設定された値と同じです。

11. motorVars_M1.flagEnableRunAndIdentify 変数を 0 に設定して、PWM をディスエーブルにします。

12. これまでの手順のいずれかで予期しない結果が得られた場合は、追加のデバッグが必要です。以下を確認してくださ
い。

a. 使用するモーター ドライバ ボードが、ビルド構成で選択したボードと同じであることを確認してください。

b. 適切な事前定義が設定されていることを確認してください。

c. セクション 4.3 に示すように、Lunchpad/ControlCARD で各スイッチが正しく構成されていることを確認してくださ

い。
13. これまでの手順が完了したら、コントローラを停止し、デバッグ接続を終了できます。まずツールバーの [Halt] ボタン

をクリックするか、[Target] → [Halt] をクリックして、コントローラを停止します。最後に、ボタンをクリックするか、[Run] 
→ [Reset] → [CPU Reset] をクリックして、コントローラをリセットします。

14. [Terminate Debug Session] ボタンをクリックするか、[Run] → [Terminate] をクリックして、CCS デバッグ セッション

を終了します。これによりプログラムが停止し、コード コンポーザが MCU から切り離されます。

15. コードを変更または再実行するたびにデバッグ セッションを終了する必要はありません。代わりに、次の手順を行うこ

とができます。プロジェクトを再ビルドしたら、ボタンを押すか、[Run] → [Reset] → [CPU Reset] をクリックした後、

[Restart] ボタンを押すか、[Run] → [Restart] をクリックします。目標デバイスや構成が変更された場合は、CCS をシ

ャットダウンする前に、プロジェクトを終了する必要があります。
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Click this button to enable 

periodic capture of data from 

the microcontroller    

Check if these variables meet the 

board, estimator, library selection

Current and voltage sampling values 

are near 0.0 with removing offset

The sensing conversion value should 

be equal to the dc bus voltage

The variable keeps increasing    

Set this variable value equal 

to 1 to start the motor

Current offset values are near 2048 

(half of 12bit ADC scale value)    

図 4-13. ビルド レベル 1：[Expressions] ウィンドウの変数
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ゲート ドライブの入力へのデッドバンド出力付き PWM を、図 4-14 に示します。

図 4-14. ビルド レベル 1：PWM 出力の波形

4.4.2 レベル 2 インクリメンタル ビルド

このビルド レベルの目標：

• 電流と電圧のセンシング回路とゲート ドライバ回路の検証のための、モーター駆動用の簡単なスカラー v/f 制御の実

装
• モーター制御用 eSMO モジュールのテスト

このビルド レベルでは、システムが開ループ制御で動作するため、ADC 値は確認と検証のためだけに使用され、ADC 
値が実際にモーターの制御ループで使用されることはありません。このビルド レベルのソフトウェア フローを 図 4-15 に
示します。
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図 4-15. ビルド レベル 2 ソフトウェア ブロック図 - 開ループ制御

4.4.2.1 プロジェクトのビルドとロード

モーターをモーター ドライバ評価ボードの適切な端子に接続します。セクション 4.4.1.1 のステップ 2～7 に従って、プロ

ジェクトをビルドして、ロードします。ステップ 4 で、DMC_BUILDLEVEL を DMC_LEVEL_2 に設定します。

4.4.2.2 デバッグ環境設定ウィンドウ

セクション 4.4.1.2 の手順に従って、変数を [Expressions] ウィンドウにインポートします。ビルド レベル 2 では、

universal_motor_control_level2.txt ファイルを選択します。 図 4-16 に示すように、[Expressions] ウィンドウが表示され

ます。
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4.4.2.3 コードの実行

1. 適切な電源に電力を供給し、電源の出力電圧を徐々に上げて、適切な DC バス電圧を取得します。

2. グラフ ツールを使用する場合、レベル 2 ではラボ 1 と同じグラフ構成とパラメータを使用して、位相電流の 2 相を監

視します。
3. [Tools] > [Arm Advanced Features] で [Data Cache Enabled] のチェックを外して、データ キャッシュをディスエー

ブルにします。
4. [Resume] ボタンをクリックしてプロジェクトを実行するか、[Debug] タブで [Run] → [Resume] をクリックします。一定

の時間が経過したら、systemVars.flagEnableSystem は 1 に設定されます。これは、オフセット較正が完了したこと

を意味します。フォルト フラグ motorVars_M1.faultMtrUse.all は 0 になります。そうでない場合は、セクション 

4.4.1.3 に示すように、レベル 1 の電流および電圧のセンシング回路を再確認する必要があります。また、

motorVars_M1.faultMtrPrev.bit の moduleOverCurrent が 1 の場合、motorSetVars_M1.overcurrent_A を高い

値に設定して、初期の大電流フォルトを回避する必要があります。
5. モーター ドライバの電流および電圧のセンシング回路を検証するには、図 4-16 に示すように、[Expressions] ウィン

ドウで変数 motorVars_M1.flagEnableRunAndIdentify を 1 に設定します。モーターは、電圧 / 周波数 (v/f) の開ル

ープで動作します。モーターがスムーズに回転しない場合、モーターの仕様に応じて、user_mtr1.h ファイルの v/f 
プロファイル パラメータを以下に示すように調整します。注：これらのパラメータを変更するには、プロジェクトをリビル

ドする必要があります。デバッグ モードでのプロジェクトのリビルドの詳細については、セクション 4.4.1.3 のステップ 

15 を参照してください。

#define USER_MOTOR1_FREQ_LOW_HZ            (5.0)            // Hz
#define USER_MOTOR1_FREQ_HIGH_HZ           (400.0)          // Hz
#define USER_MOTOR1_VOLT_MIN_V             (1.0)            // Volt
#define USER_MOTOR1_VOLT_MAX_V             (24.0)           // Volt

6. motorVars_M1.speedRef_Hz 変数は、モーターの速度リファレンスを設定するために使用されます。[Expressions] 
ウィンドウで motorVars_M1.speed_Hz 変数の値をチェックして、図 4-16 に示すように、モーター速度 

(motorVars_M1.speed_Hz) がリファレンス速度 (motorVars_M1.speedRef_Hz) に近いことを確認します。

7. このビルド レベルでは、電流センシング、電圧センシング、回転子角度エスティメータ、ジェネレータを検証する必要

があります。これは、セクション 4.5.2 に示すように、HV モーター キットの PWMDAC を使用して実行できます。さら

に、DATALOG モジュールを使用して、これらのセンシング波形を表示することもできます。DATALOG モジュールを

使用して電流、電圧、角度信号を表示する方法の詳細については、ステップ 8 を参照してください。

8. DATALOG モジュールをグラフ ツールと一緒に使用して電流センシング信号、電圧センシング信号、および角度出

力をチェックする場合は、次に説明する手順に従ってください。DATALOG モジュールの詳細については、セクション 

4.5.1 を参照してください。注：コードを変更した後、次の各ステップの間でプロジェクトをリビルドする必要があります。

a. DATALOG モジュールを使用して位相電流をテストするには、sys_main.c ファイルで次のコードを設定する必要

があります。注：このコードは、デフォルトでビルド レベル 2 にすでに構成されています。グラフ ツールに表示さ

れる位相電流サンプリング信号の波形は、図 4-18 のとおりです。

datalogObj->iptr[0] = (float32_t*) &motorVars_M1.adcData.I_A.value[0];
datalogObj->iptr[1] = (float32_t*) &motorVars_M1.adcData.I_A.value[1];

b. DATALOG モジュールを使用して位相電圧をテストするには、sys_main.c ファイルで次のコードを設定する必要

があります。グラフ ツールに表示される位相電圧サンプリング信号の波形は、図 4-19 のとおりです。

datalogObj->iptr[2] = (float32_t*) &motorVars_M1.adcData.V_V.value[0];

c. フォース角度ジェネレータまたはエスティメータからの角度は、図 4-21 に示すように、グラフ ツールで監視できま

す。フォース角度ジェネレータの角度が eSMO エスティメータの推定回転子角度と非常に類似していることに注

意してください。

datalogObj->iptr[3] = (float32_t*) &motorVars_M1.angleFOC_rad;

9. 変数 motorVars_M1.overCurrent_A の値を小さくすることで、過電流フォルト保護を検証します。過電流保護は 

CMPSS モジュールによって実装されています。図 4-17 に示すように、motorVars_M1.overCurrent_A がモーター

位相電流の実際値よりも小さい値に設定され、PWM 出力がディセーブルされ、

motorVars_M1.flagEnableRunAndIdentify が 0 にクリアされると、過電流フォルトがトリガされます。

10. 変数 motorVars_M1.flagEnableRunAndIdentify を 0 に設定し、モーターの動作を停止します。
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11. 完了したら、コントローラを停止して、デバッグ接続を終了できます。まずツールバーの [Halt] ボタンをクリックするか、

[Target] → [Halt] をクリックして、コントローラを完全に停止します。最後に、[CPU Reset] をクリックするか、[Run] → 

[Reset] をクリックして、コントローラをリセットします。

12. [Terminate Debug Session] ボタンをクリックするか、[Run] → [Terminate] をクリックして、CCS デバッグ セッション

を終了します。
13. インバータ キットの電源を切ります。

Click this button to enable periodic capture of 

data from the microcontroller  

Check if these variables meet the board and 

estimator selections

Set this variable value equal to 1 to start run 

the motor

The threshold value of the over current 

protection

Means the inverter/controller has fault when 

run the motor if the variable value is not zero

Set target speed value (Hz) to this variable

The sensing conversion value should be 

equal to the dc bus voltage

Check if the estimation speed (Hz) is equal/

close to the setting traget speed (Hz)

図 4-16. ビルド レベル 2：[Expressions] ウィンドウの変数

図 4-17 に示すように、[Expression] ウィンドウで motorVars_M1.overCurrent_A の値を調整して、過電流フォルトをトリ

ガします。

The value will be non-zero if there 

is an over-current fault

The values will be non-zero if 

there is an over-current fault

Set the right current threshold 

value to verify the over current 

function

図 4-17. ビルド レベル 2：電流保護の設定
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図 4-18 に示すように、データログをグラフ ツールと一緒に使用して、モーターの 3 相センシング電流を監視します。

図 4-18. ビルド レベル 2：グラフ ツールによるモーター位相電流の波形

図 4-19 に示すように、データログをグラフ ツールと一緒に使用して、モーターの 3 相センシング電圧を監視します。ここ

で選択されている SVM モードは、最小変調の DPWM です。

図 4-19. ビルド レベル 2：グラフ ツールによるモーター位相電圧の波形 - 最小 DPWM

図 4-20 に示すように、データログをグラフ ツールと一緒に使用して、SVPWM の一般的な変調によるモーターの 3 相セ

ンシング電圧を監視します。SVM タイプは motor1_drive.c ファイルで選択できます。

図 4-20. ビルド レベル 2：グラフ ツールによるモーター位相電圧の波形 - 一般的な SVPWM

図 4-21 に示すように、データログをグラフ ツールと一緒に使用して、角度ジェネレータからのモーター角度と eSMO エ
スティメータからの角度を監視します。
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図 4-21. ビルド レベル 2：グラフ ツールによるモーターの回転子角度の波形

4.4.3 レベル 3 インクリメンタル ビルド

このビルド レベルの目標：

• モーターの閉電流ループ動作を評価する

• 電流センシング パラメータ設定を検証する

このビルド レベルでは、モーターは i/f 制御を使用して制御され、回転子角度はランプ ジェネレータ モジュールから生成

されます。このビルド レベルのソフトウェア フローを 図 4-22 に示します。
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図 4-22. ビルド レベル 3 ソフトウェアのブロック図 – 電流の閉ループ制御

4.4.3.1 プロジェクトのビルドとロード

モーターを電力インバータ ボードの関連する端子に接続します。セクション 4.4.1.1 の操作手順に従って、

sys_settings.h ファイルで DMC_BUILDLEVEL を DMC_LEVEL_3 に設定し、プロジェクトをビルドしてロードします。
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4.4.3.2 デバッグ環境設定ウィンドウ

セクション 4.4.1.2 の操作手順に従って、universal_motor_control_level3.txt を選択して、変数を [Expressions] ウィン

ドウにインポートします。 図 4-23 に示すように、[Expressions] ウィンドウが表示されます。

4.4.3.3 コードの実行

1. AC 電源または DC 電源に電力を供給し、電源の出力電圧を徐々に上げて、適切な DC バス電圧を取得します。

2. [Tools] > [Arm Advanced Features] で [Data Cache Enabled] のチェックを外して、データ キャッシュをディスエー

ブルにします。 
3. [Resume] ボタンをクリックしてプロジェクトを実行するか、[Debug] タブで [Run] → [Resume] をクリックします。 一定

の時間が経過したら、systemVars.flagEnableSystem を 1 に設定する必要があります。これよって、オフセット較正

が完了します。 フォルト フラグ motorVars_M1.faultMtrUse.all は 0 ですが、そうでない場合は、セクション 4.4.1 に
示すように、電流および電圧のセンシング回路をチェックする必要があります。 

4. 電流閉ループ制御でモーターが動作することを検証するには、図 4-23 に示すように、[Expressions] ウィンドウで変

数 motorVars_M1.flagEnableRunAndIdentify を 1 に設定します。 モーターは、変数 

motorVars_M1.speedRef_Hz の設定速度で角度ジェネレータからの角度使用して、閉ループ制御で動作します。

[Expressions] ウィンドウで、motorVars_M1.speed_Hz の値を確認します。両変数は非常に近い値です。

5. オシロスコープのプローブを EPWMDAC (HV キット用) 出力とモーターの位相ラインに接続し、角度と電流信号、電

流をプローブします。これらの波形はオシロスコープで、図 4-24 のように表示されます。[Expressions] ウィンドウで 

motorVars_M1.Idq_set_A.value[1] を変更してリファレンス トルク電流を設定すると、それに応じてモーター位相電

流が同じ割合で増加します。

6. 電流閉ループ制御でモーターが動作せず、過電流フォルトが表示される場合は、
motorVars_M1.adcData.current_sf の符号と userParams_M1.current_sf の値がハードウェア ボードに応じて正

しく設定されているかどうかを確認します。 両変数の値は、user_mtr1.h ファイルの定義定数 

USER_M1_ADC_FULL_SCALE_CURRENT_A に関連しています。

7. 変数 motorVars_M1.flagEnableRunAndIdentify を 0 に設定し、モーターの動作を停止します。

8. 完了したら、コントローラを停止して、デバッグ接続を終了できます。まずツールバーの [Suspend] ボタンをクリックす

るか、[Target] → [Halt] をクリックして、コントローラを完全に停止します。 最後に、[CPU Reset] ボタンをクリックする

か、[Run] → [Reset] をクリックして、コントローラをリセットします。 
9. [Terminate Debug Session] ボタンをクリックするか、[Run] → [Terminate] をクリックして、CCS デバッグ セッション

を終了します。 
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Click this button to enable periodic capture 

of data from the microcontroller  

Check if these variables meet the board 

and estimator selections

Set this variable value equal to 1 to start 

run the motor

Tune these Kp or Ki to achieve the required 

response

Set the reference torque current value to 

this variable

Means the inverter/controller has fault 

when run the motor if the variable value is 

not zero

Set target speed value (Hz) to this variable

The sensing conversion value should be 

equal to the dc bus voltage

Check if the estimation speed (Hz) is equal/

close to the setting traget speed (Hz)

The threshold value of the over current 

protection

図 4-23. ビルド レベル 3：[Expressions] ウィンドウの変数

The rotor angle value output with PWMDAC The phase A current sensing value output 

with PWMDAC

図 4-24. ビルド レベル 3：EPMWDAC によるモーターの回転子角度と位相電流波形の監視

4.4.4 レベル 4 インクリメンタル ビルド

このビルド レベルの目標：

• eSMO ベースのセンサレス FOC、エンコーダ ベースのセンサ付き FOC、ホール ベースのセンサ付き FOC を使用し

て、モーター ドライブ全体を評価する

• 弱め界磁制御、フライング スタート、MTPA、ブレーキなどの追加機能を評価する

このビルド レベルでは、回転子角度が eSMO モジュール、エンコーダ モジュール、またはホール センサー モジュール

から取得されるモーターの場合、外側の速度ループは内側の電流ループで閉じられます。このビルド レベルのソフトウェ

ア フローを 図 4-25 に示します。
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図 4-25. ビルドレベル 4 ソフトウェアのブロック図 – 速度と電流の閉ループ制御

4.4.4.1 プロジェクトのビルドとロード

モーターを電力インバータ ボードの関連する端子に接続します。セクション 4.4.1.1 の操作手順に従って、

sys_settings.h ファイルで DMC_BUILDLEVEL を DMC_LEVEL_4 に設定し、プロジェクトをビルドしてロードします。

4.4.4.2 デバッグ環境設定ウィンドウ

セクション 4.4.1.2 の操作手順に従って、universal_motor_control_level4.txt を選択して、変数を [Expressions] ウィン

ドウにインポートします。 図 4-26 に示すように、[Expressions] ウィンドウが表示されます。

4.4.4.3 コードの実行

1. AC 電源または DC 電源に電力を供給し、電源の出力電圧を徐々に上げて、適切な DC バス電圧を取得します。

2. 以下のサンプル コードに示すように、必要なモーター パラメータは user_mtr1.h ヘッダー ファイルで定義されている

必要があります。

#define USER_MOTOR1_TYPE MOTOR_TYPE_PM
#define USER_MOTOR1_NUM_POLE_PAIRS (4)
#define USER_MOTOR1_Rr_Ohm (NULL)
#define USER_MOTOR1_Rs_Ohm (0.38157931f)
#define USER_MOTOR1_Ls_d_H (0.000188295482f)
#define USER_MOTOR1_Ls_q_H (0.000188295482f)
#define USER_MOTOR1_RATED_FLUX_VpHz (0.0396642499f)

3. プロジェクトをビルドしてコードをコントローラにロードし、[Tools] > [ARM Advanced Features] で [Data Cache 
Enabled] のチェックを外してデータ キャッシュを無効にし、[Resume] ボタンをクリックしてプロジェクトを実行するか、

[Debug] タブで [Run] → [Resume] をクリックします。 一定の時間が経過したら、systemVars.flagEnableSystem 
は 1 に設定されます。これは、オフセット較正が完了し、導通時には電力リレーがオンになったことを意味します。 フ
ォルト フラグ motorVars_M1.faultMtrUse.all は 0 になります、そうでない場合は、セクション 4.4.1 に示すように、電

流および電圧のセンシング回路をチェックする必要があります。 
4. 図 4-26 に示すように、[Expressions] ウィンドウで変数 motorVars_M1.flagEnableRunAndIdentify を 1 に設定しま

す。 
5. モーターを始動した後、以下の手順に従ってください。

a. 目標速度値を変数 motorVars_M1.speedRef_Hz に設定し、モーター シャフトの速度がどのように設定速度を

追従するかを注意深く観察します。

www.ti.com/ja-jp ハードウェア、ソフトウェア、テスト要件、テスト結果

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

49

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


b. 加速度を変更するには、変数 motorVars_M1.accelerationMax_Hzps に異なる加速度値を入力します。

c. PWMDAC モジュールを使用して、セクション 4.5.2 に示すように監視変数を表示します。モーターの角度と電流

波形を 図 4-27 に示します。

6. FOC システムの電流コントローラのデフォルトの比例ゲイン (Kp) と積分ゲイン (Ki) は、関数 setupControllers() で
計算されます。setupControllers() が呼び出されると、グローバル変数 motorSetVars_M1.Kp_Id、

motorSetVars_M1.Ki_Id、motorSetVars_M1.Kp_Iq、motorSetVars_M1.Ki_Iq が、新しく計算された Kp ゲインお

よび Ki ゲインで初期化されます。 図 4-26 に示すように、これら 4 つの変数の Kp と Ki の値を、予想される電流制

御の帯域幅と応答が得られるように、電流コントローラの [Expressions] ウォッチ ウィンドウで調整します。Kp ゲイン

により、モーターの固定子の極を打ち消すゼロが生成され、簡単に計算できます。Ki ゲインにより、電流コントローラ - 
モーター システムの帯域幅が調整されます。速度制御システムに一定のダンピングが必要な場合、電流コントローラ

の Kp ゲインは速度制御システムの時定数に関連しています。

7. 変数 motorVars_M1.flagEnableRunAndIdentify を 0 に設定し、モーターの動作を停止します。 
8. 完了したら、コントローラを停止して、デバッグ接続を終了できます。まずツールバーの [Suspend] ボタンをクリックす

るか、[Target] → [Halt] をクリックして、コントローラを完全に停止します。 最後に、[CPU Reset] ボタンをクリックする

か、[Run] → [Reset] をクリックして、コントローラをリセットします。 
9. [Terminate Debug Session] ボタンをクリックするか、[Run] → [Terminate] をクリックして、CCS デバッグ セッション

を終了します。 

Click this button to enable periodic 

capture of data from the microcontroller  

Supporting estimator

Set this variable value equal to 1 to start 

motor

Set target speed value (Hz) to this 

variable

Estimation feedback speed (Hz)

The threshold value of the over current 

protection

Tune these Kp or Ki of current and 

speed regulators to achieve the required 

response

Motor operation state
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Measured speed when encoder is 

enabled

Measured speed when Hall sensor is 

enabled

図 4-26. ビルド レベル 4：[Expressions] ウィンドウの変数
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Rotor angle value output with Data Log 
module

Rotor angle value output with Data 
Log module

図 4-27. ビルド レベル 4：順方向動作時の eSMO 波形による位相電流と回転子角度

セクション 4.2.2 に示すように、このプロジェクトでは複数の FOC アルゴリズムをサポートすることが可能であり、モーター

制御に 1 つ (eSMO、ホール、エンコーダ) のアルゴリズムまたは 2 つのアルゴリズム (eSMO + エンコーダ) を使用できま

す。

セクション 4.2.1 に示すように、プロジェクト プロパティに MOTOR1_ESMO と MOTOR1_ENC という事前定義名を追加

することにより、eSMO エスティメータとエンコーダ エスティメータをプロジェクトに同時に実装できます。 上記の操作手順

に従って、プロジェクトをリビルド、ロード、実行します。

• systemVars.estType の値は EST_TYPE_ESMO_ENC に等しく、これはこのプロジェクトでは eSMO エスティメータ

とエンコーダ エスティメータが有効になっていることを意味します。

• motorVars_M1.estimatorMode が ESTIMATOR_MODE_ESMO に等しいのは、eSMO エスティメータがセンサレ

ス FOC に使用されていることを意味し、ESTIMATOR_MODE_ENC に等しいのは、エンコーダ エスティメータがセン

サ付き FOC に使用されていることを意味します。

• eSMO およびエンコーダから推定された回転子角度を 図 4-28 に示します。motorVars_M1.speedRef_Hz を正の

値に設定することで、モーターは eSMO により順方向で動作します。

• この値を ESTIMATOR_MODE_ENC に変更すれば、センサ付き FOC 用のエンコーダ エスティメータを選択できま

す。また、この値を変更すれば、使用するエスティメータをその場で切り替えることもできます。
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Feedback speed with 

Data Log module

eSMO rotor angle value 

output with Data Log 

module

Encoder rotor angle value 

output with Data Log 

module

図 4-28. ビルド レベル 4：eSMO とエンコーダによる回転子角度、順方向動作時の位相電流波形
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4.5 モーター制御プロジェクトへのその他の追加の機能

4.5.1 DATALOG 機能の使用

図 4-29 に示すように、DATALOG モジュールでは、ユーザーが選択可能なソフトウェア変数 (デフォルトでは 4 つの変

数) のリアルタイム値がテキサス・インスツルメンツの MCU に搭載されているデータ RAM に保存されます。これら 4 つの

変数は、モジュール入力を 4 つの変数のアドレスに構成することで選択されます。4 つの RAM バッファ位置の開始アド

レスは、&((datalog).datalogBuff)[0]、&((datalog).datalogBuff)[1]、&((datalog).datalogBuff)[2]、
&((datalog).datalogBuff)[3] となります。これらのデータログ バッファは、グラフに表示できる値トリガー データを含む大き

な配列です。データログ プリスケーラは構成可能であるため、データ ログ機能により、プリスケーラのサンプリングごとに 1 
つのサンプルのみをログに記録できます。データログ バッファの数、バッファ サイズ、データ タイプは、datalog_input.h 
ファイルで選択できます。

DATLOG 

Update

GSx

RAM

H/W

datalogObj.iptr[0]

datalogObj.iptr[1]

datalogObj.iptr[2]

datalogObj.iptr[3]

図 4-29. DATALOG モジュールのブロック図

データログ機能をイネーブルにするには、図 4-2 に示すように、プロジェクト プロパティに事前定義シンボル 

DATALOG_EN を追加する必要があります。

以下のコードは、1 つの DATALOG のオブジェクトとハンドルの宣言を示しています。このコードは datalog.c ファイルに

あります。

__attribute__ ((section("datalog_data"))) DATALOG_Obj datalog;
DATALOG_Handle datalogHandle;       //!< the handle for the Datalog object

これにより、DATALOG オブジェクトはメモリの datalog_data セクションに格納されます。このセクションは TCM または 

OCRAM のいずれかになります。一般的に、TCM は容量が限られており、ソフトウェアの時間的制約がある部分で必要と

されるため、OCRAM の使用をお勧めします。CCS12.6 で OCRAM にデータをロギングできるように、データ キャッシュ

を無効にします。データキャッシュを無効にするには、図 4-30 に示すように、[Tools] > [ARM Advanced Features] で 

[Data Cache Enabled] のチェックを外す必要があります。

Disable cache to be able real time 

debugging of variables stored in OCRAM

図 4-30. リアルタイム デバッグのためにデータ キャッシュを無効にする
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以下のコードは、DATALOG のオブジェクト、ハンドル、およびパラメータの初期化と設定を示しています。このコードは 

sys_main.c ファイルにあります。

// Initialize Datalog    
datalogHandle = DATALOG_init(&datalog, sizeof(datalog), manual, 0, 1);
DATALOG_Obj *datalogObj = (DATALOG_Obj *)datalogHandle;

以下のコードは、変数のアドレスを指すようにモジュール入力の構成を示しています。DATALOG モジュールの入力は、

ビルド レベルに応じて異なるシステム変数を指します。このコードは sys_main.c ファイルにあります。

datalogObj->iptr[0] = (float32_t*) &motorVars_M1.adcData.V_V.value[0];
datalogObj->iptr[1] = (float32_t*) &motorVars_M1.adcData.I_A.value[0];
datalogObj->iptr[2] = (float32_t*) &motorVars_M1.adcData.I_A.value[1];
datalogObj->iptr[3] = (float32_t*) &motorVars_M1.angleFOC_rad;

以下のコードは、motor1ctrlISR() 割り込みの実行中に、データログ バッファが新しいデータで定期的に更新されること

を示しています。このコードは motor1_drive.c ファイルにあります。

#if defined(DATALOG_EN)
DATALOG_update(datalogHandle);
#endif  // DATALOG_EN

DATALOG モジュールはグラフ ツールと一緒に使用され、変数を視覚的に表示して検査し、システム性能を判定する手

段を提供します。グラフ ツールは CCS で使用可能であり、データの配列をさまざまな種類のグラフで表示できます。デー

タの配列は、さまざまな形式でデバイスのメモリに保存されます。

プロジェクトがデバッグ モードの間に、図 4-31 に示すように、データ ログ バッファをプロットするための時間グラフ ウィン

ドウを開いて設定します。または、プロジェクト フォルダにあるグラフ構成ファイルをインポートすることもできます。インポー

トするには、[Tools] -> [Graph] -> [Single Time…] をクリックして [Import] を選択し、次の場所 
<workspace>\universal_motorcontrol_am263x_r5fss0-0_nortos_ti-arm-

clang\src_control\debug\ を参照して、datalog.graphProp ファイルを選択します。[OK] をクリックすると、

[Debug] パースペクティブにグラフが追加されます。[Graph] タブの左上隅にある [Continuous Refresh] ボタンをクリック

します。
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The start address of the data log 

buffer

Equals to the size of he data log 

buffer

Set the data type as the 

software variables

Equals to datalog update 

frequency

Equals to the size of he data log 

buffer

Import the example .graphProp 

file

図 4-31. グラフ ウィンドウの設定
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4.5.2 PWMDAC 機能の使用

PWMDAC モジュールは、図 4-32 に示すように、ePWM 5A、5B、6A、6B を使用してソフトウェア変数を PWM 信号に

変換します。PWMDAC モジュールは、RC フィルタが適用された追加 PWM 出力がボード上にあるため、高電圧キット 

(TMDSHVMTRINSPIN) のみでサポートされます。PWMDAC モジュールが PWMDAC モジュールをサポートしていな

いモーター ドライバ ボードと一緒に使用される場合、PWM 信号はテキサス・インスツルメンツの LaunchPad 上の予備の 

PWM にルーティングされ、ユーザーは PWMDAC デザインを利用するためにこれらのピンに RC フィルタを追加する必

要があります。

PWMDAC 

Update

PWM

H/W

pwmDACData.ptrData[0]
EPWM5A

pwmDACData.ptrData[1]

pwmDACData.ptrData[2]

EPWM5B

EPWM6A

図 4-32. PWMDAC モジュールのブロック図

PWMDAC モジュールを使用すると、外部ローパス フィルタを介した関連するピンの出力で、変数で表される信号を確認

できます。そのため、図 4-33 に示すように、実際の信号波形を表示するには、外部ローパス フィルタが必要です。(1 次) 
RC ローパス フィルタは、実際の低周波信号に組み込まれている高周波成分をフィルタリングするために使用されます。

R 値と C 値を選択するには、次の式に示すように、時定数をカットオフ周波数 (fc) で表すことができます。

τ = RC = 12πfc (62)

fc = 2πRC (63)
470�

0.47μF

GND

PWM

Scope

Scope

図 4-33. PWM ピンに接続した外部 RC ローパス フィルタ

ePWM DAC 機能を有効にするには、図 4-2 に示すように、事前定義されたシンボル EPWMDAC_MODE をプロジェク

ト プロパティに追加する必要があります。

次のコードは、PWMDAC オブジェクトの宣言を示しています。このコードは sys_main.c ファイルにあります。

#if defined(EPWMDAC_MODE)
#if defined(HVMTRPFC_REV1P1)
__attribute__ ((section("sys_data"))) HAL_PWMDACData_t pwmDACData;
  // HVMTRPFC_REV1P1
#else
#error EPWMDAC is not supported on this kit!
#endif  // !HVMTRPFC_REV1P1
#endif  // EPWMDAC_MODE

以下のコードは、PWMDAC のオブジェクト、ハンドル、およびパラメータの初期化と設定を示しています。4 つのモジュー

ル入力である ptrData[0]、ptrData[1]、ptrData[2]、ptrData[3] は、4 つの変数のアドレスを指すように構成されています。

PWMDAC モジュールの入力は、ビルド レベルに応じて異なるシステム変数を指します。このコードは sys_main.c ファイ

ルにあります。

// set DAC parameters
pwmDACData.periodMax =
        PWMDAC_getPeriod(halHandle->pwmDACHandle[PWMDAC_NUMBER_1]);
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pwmDACData.ptrData[0] = &motorVars_M1.angleFOC_rad;               // PWMDAC1
pwmDACData.ptrData[1] = &motorVars_M1.speedAbs_Hz;                // PWMDAC2
pwmDACData.ptrData[2] = &motorVars_M1.speedAbs_Hz;                // PWMDAC3
pwmDACData.ptrData[3] = &motorVars_M1.adcData.I_A.value[1];       // PWMDAC4

pwmDACData.offset[0] = 0.5f;    // PWMDAC1
pwmDACData.offset[1] = 0.0f;    // PWMDAC2
pwmDACData.offset[1] = 0.0f;    // PWMDAC3
pwmDACData.offset[3] = 0.5f;    // PWMDAC4

pwmDACData.gain[0] = 1.0f / MATH_TWO_PI;                          // PWMDAC1
pwmDACData.gain[1] = 1.0f / USER_MOTOR1_FREQ_MAX_Hz;              // PWMDAC2
pwmDACData.gain[2] = 1.0f / USER_MOTOR1_FREQ_MAX_Hz;              // PWMDAC3
pwmDACData.gain[3] = 2.0f / USER_M1_ADC_FULL_SCALE_CURRENT_A;     // PWMDAC4

以下のコードは、motor1ctrlISR() 割り込みの実行中に、PWM 出力が新しいデータで更新されることを示しています。こ

のコードは motor1_drive.c ファイルにあります。

// connect inputs of the PWMDAC module. 
HAL_writePWMDACData(halHandle, &pwmDACData);

4.5.3 CAN 機能の追加

CAN 機能をラボ プロジェクトに追加することで、スタート / ストップ コマンドを送信し、フィードバックの実行状態を取得す

るための通信バスを提供することができます。これを利用するには、図 4-2 に示すように、プロジェクト ビルド プロパティで

事前定義シンボル CMD_CAN を有効にします。PCAN-View は、CAN データ トラフィックの監視、送信、記録を行うため

だけに使用されます。motor_common.h ファイルでは、異なる種類のコマンド メッセージを定義できます。このプロジェク

トでは例として、送信者は開始コマンドを指定し、目標速度の値を定義します。受信者は、目標速度を含むメッセージを受
信します。

キットの LaunchPad または EVM のどちらを使用するかによっては、特定のピン多重化設定が必要であることに注意して

ください。これらの構成は、次のコードで説明するように、mcanEnableTransceiver 関数と tca6416ConfigOutput 関数を

使用して実現されます。 

#if defined(AM263_CC)
void tca6416ConfigOutput(uint16_t port, uint16_t pin, uint16_t level);
#endif // AM263_CC

#if defined(CMD_CAN)
#if defined(AM263_LP)

void mcanEnableTransceiver(void)
{
    uint32_t    gpioBaseAddr, pinNum;

    gpioBaseAddr = (uint32_t)AddrTranslateP_getLocalAddr(MCAN_ENABLE_BASE_ADDR);
    pinNum       = MCAN_ENABLE_PIN;

    GPIO_setDirMode(gpioBaseAddr, pinNum, GPIO_DIRECTION_OUTPUT);

    GPIO_pinWriteLow(gpioBaseAddr, pinNum);
}
#endif // AM263_LP

#if defined(AM263_CC)
/* ========================================================================== */
/*                           Macros & Typedefs                                */
/* ========================================================================== */

/* Input status register */
#define TCA6416_REG_INPUT0              ((UInt8) 0x00U)
#define TCA6416_REG_INPUT1              ((UInt8) 0x01U)

/* Output register to change state of output BIT set to 1, output set HIGH */
#define TCA6416_REG_OUTPUT0             ((uint8_t) 0x02U)
#define TCA6416_REG_OUTPUT1             ((uint8_t) 0x03U)

/* Configuration register. BIT = '1' sets port to input, BIT = '0' sets
 * port to output */
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#define TCA6416_REG_CONFIG0             ((uint8_t) 0x06U)
#define TCA6416_REG_CONFIG1             ((uint8_t) 0x07U)

/* ========================================================================== */
/*                          Function Declarations                             */
/* ========================================================================== */
static void SetupI2CTransfer(I2C_Handle handle,  uint32_t targetAddr,
                      uint8_t *writeData, uint32_t numWriteBytes,
                      uint8_t *readData,  uint32_t numReadBytes);

void mcanEnableTransceiver(void)
{
    I2C_Handle      i2cHandle;
    uint8_t         dataToSlave[4];

    i2cHandle = gI2cHandle[CONFIG_I2C0];
    dataToSlave[0] = TCA6416_REG_CONFIG0;
    dataToSlave[1] = 0x0U;
    SetupI2CTransfer(i2cHandle, 0x20, &dataToSlave[0], 1, &dataToSlave[1], 1);
    /* set the P00 to 0 make them output ports. */
    dataToSlave[1] &= ~(0x1U);
    SetupI2CTransfer(i2cHandle, 0x20, &dataToSlave[0], 2, NULL, 0);

    /* Get the port values. */
    dataToSlave[0] = TCA6416_REG_INPUT0;
    dataToSlave[1] = 0x0U;
    SetupI2CTransfer(i2cHandle, 0x20, &dataToSlave[0], 1, &dataToSlave[1], 1);

    /* Set P10 and P11 to 0.
     */
    dataToSlave[0] = TCA6416_REG_OUTPUT0;
    dataToSlave[1] &= ~(0x1);
    SetupI2CTransfer(i2cHandle, 0x20, &dataToSlave[0], 2, NULL, 0);
}

static void SetupI2CTransfer(I2C_Handle handle,  uint32_t targetAddr,
                      uint8_t *writeData, uint32_t numWriteBytes,
                      uint8_t *readData,  uint32_t numReadBytes)
{
    int32_t status;
    I2C_Transaction i2cTransaction;

    /* Enable Transceiver */
    I2C_Transaction_init(&i2cTransaction);
    i2cTransaction.targetAddress = targetAddr;
    i2cTransaction.writeBuf = (uint8_t *)&writeData[0];
    i2cTransaction.writeCount = numWriteBytes;
    i2cTransaction.readBuf = (uint8_t *)&readData[0];
    i2cTransaction.readCount = numReadBytes;
    status = I2C_transfer(handle, &i2cTransaction);
    DebugP_assert(SystemP_SUCCESS == status);
}

#endif // AM263_CC
#endif // CMD_CAN

PCAN-View を起動したら、図 4-34 のように CAN アダプタのセットアップを行います。
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図 4-34. PCAN-View の設定

図 4-35 に示すように、ダブルクリックして CAN データ送信を開始します。

Double click on the 

message to transmit the 

commands

図 4-35. CAN データ送信の開始

図 4-36 に示すように、motorVars_M1.flagEnableRunAndIdentify は 1、motorVars_M1.speedRef_Hz は 40Hz が設

定されています。 この速度値は CAN 通信を介して受信者に送信されます。
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Start command received from CAN

Speed value (Hz) received from CAN 

command

図 4-36. CAN コマンド：[Expressions] ウィンドウの変数

4.5.4 SFRA 機能の追加

テキサス・インスツルメンツのソフトウェア周波数応答アナライザ (SFRA) ライブラリは、外部の周波数応答アナライザを使

用せずに、ソフトウェアのみを使用してパワー コンバータの周波数応答解析が行えるように設計されています。最適化さ

れたライブラリは、高周波電力変換アプリケーションにおいて、閉ループ パワー コンバータのプラント特性、閉ループ ゲ
イン特性、開ループ ゲイン特性を特定するために使用でき、ゲイン マージン、位相マージン、開ループ ゲイン クロスオー

バー周波数などの安定性情報を取得し、制御ループの性能評価に使用できます。

図 4-37 に示すような、デジタル制御の閉ループ パワー コンバータを考えてみましょう。

• H は、制御が必要なプラントの伝達関数です

• G は、デジタル補償器です

• GH は、開ループ伝達関数と呼ばれます

• CL は、閉ループ伝達関数と呼ばれ、GH/(1+GH) です

• r は、瞬間的な設定点またはコンバータのリファレンスです

• Ref は、DC 設定点のリファレンスです

• y は、A/D コンバータ (ADC) の帰還です

• e は、瞬間的な誤差です

• d は、センサのノイズと外乱です

• u は、PWM デューティ サイクルです

閉ループ システムにおける補償器には、主に次のような目的があります。

• システムが安定していることを確認する (たとえば、システムは漸近的にリファレンスを追従する)e = limt ∞  e t = limt ∞ r1 + GH 0 (64)

• システムによる外乱の排除により、堅牢な動作を維持するS = yd = 11 + GH 0 (65)
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図 4-37. デジタル制御のパワー コンバータ

システムが目的を達成しているかどうかは、式 64 と 式 65 で示される開ループ伝達関数 (GH) を知ることで判断できま

す。

この目的のために、開ループ伝達関数 GH のボード線図が頻繁に使用され、ゲイン マージン (GM)、位相マージン 

(PM)、開ループ ゲイン クロスオーバー周波数 (Folg_cf) などの数値が、閉ループ パワー コンバータの安定性や堅牢性

を評価するためによく使用されます。

閉ループ伝達関数 (GH/(1+GH)) は、システムがコマンド リファレンスにどの程度追従できるかを示すものです。

SFRA ライブラリは、GH、GH/(1+GH)、H 周波数応答をソフトウェアを使用して測定できます。このデータは、次のような

目的で使用できます。

• プラント モデル (H) の検証またはプラント モデル (H) の抽出

• 閉ループ プラントの補償器 (G) の設計

• 開ループ (GH) または閉ループ [GH÷(1+GH)] のボード線図をプロットし、システムの閉ループ性能を検証します。

GH と H の周波数応答はプラントの情報を伝達するため、周波数応答を定期的に測定することで、データを使用して出

力段の状態を評価することができます。

SFRA ライブラリは正弦波注入の原理に基づいており、注入振幅によってコンバータの通常の動作点に対する偏差が非

常に小さくなることを前提としています。SFRA ライブラリは、パワー コンバータの制御コードに統合することができます。

本書では、その手順について詳しく説明します。GH、H、CL の計算はすべて MCU で行われ、GH、H、CL の振幅と位

相応答の配列全体がコントローラに保存されます。

コードに統合された後は、SFRA ライブラリを使用してコントローラの設計や微調整を行うことができます。SFRA ライブラリ

の一般的な使用フローは次のとおりです。

1. 開ループで SFRA 掃引を開始し、データを Excel ファイルに保存します。この情報をもとに、SFRA 掃引が実行され

た定常状態の動作点について、プラント モデルを特定することができます。

2. このプロジェクトに付属している MATLAB® スクリプトを使用すると、そのデータを MATLAB に読み取り、応答を伝達

関数の曲線に当てはめることができます。これで、Sisotool を使用した補償器の設計が可能になります。

3. 新しい補償器の値は、MATLAB から Code Composer Studio™ プロジェクトにコピーできます。

4. 新しい係数を含むコードをコンパイルし、電力段を制御するマイクロコントローラにロードします。SFRA アルゴリズム 

(ステップ 1) を再実行し、開ループ ゲイン GH (文献ではループ ゲインとも呼ぶ) を測定することで、閉ループのシス

テム性能を検証できます。

まとめとして、テキサス・インスツルメンツのソフトウェア周波数応答アナライザは、パワー コンバータを系統的な方法で調

整する手法を提供し、外部接続や装置を必要とすることなく、迅速かつ簡単にパワー コンバータの周波数応答を解析す

ることができます。外部接続を使用しないため、SFRA を繰り返し実行して、定期的にパワー コンバータの状態を評価し、

診断情報を取得できます。

4.5.4.1 動作原理

ソフトウェア周波数応答アナライザは、小信号の正弦波注入の原理に基づいています。図 4-38 に示すように、コントロー

ラのリファレンスに小信号を注入し、フィードバック出力とコントローラ出力の周波数応答が計算されします。これにより、プ
ラントの周波数応答特性と、閉ループ システムの開ループ周波数応答が得られます。
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図 4-38. SFRA の動作原理

4.5.4.2 オブジェクトの定義

SFRA ライブラリでは、浮動小数点ベースの SFRA 構造を次のように定義しています。

typedef struct{
  float32_t *h_magVect;     //!< Plant Mag SFRA Vector     
  float32_t *h_phaseVect;   //!< Plant Phase SFRA Vector     
  float32_t *gh_magVect;    //!< Open Loop Mag SFRA Vector     
  float32_t *gh_phaseVect;  //!< Open Loop Phase SFRA Vector     
  float32_t *cl_magVect;    //!< Closed Loop Mag SFRA Vector     
  float32_t *cl_phaseVect;  //!< Closed Loop Phase SFRA Vector
  float32_t *freqVect;      //!< Frequency Vector     
  float32_t amplitude;      //!< Injection Amplitude     
  float32_t isrFreq;        //!< SFRA ISR frequency     
  float32_t freqStart;      //!< Start frequency of SFRA sweep     
  float32_t freqStep;       //!< Log space between frequency points (optional)
  int16_t start;            //!< Command to start SFRA     
  int16_t state;            //!< State of SFRA     
  int16_t status;           //!< Status of SFRA     
  int16_t vecLength;        //!< No. of Points in the SFRA     
  int16_t freqIndex;        //!< Index of the frequency vector 
  int16_t storeH;           //!< Flag to indicate if H vector is stored  
  int16_t storeGH;          //!< Flag to indicate if GH vector is stored 
  int16_t storeCL;          //!< Flag to indicate if CL vector is stored 
  int16_t speed;            //!< variable to change the speed of the sweep
}SFRA_F32;

4.5.4.3 モジュール インターフェイスの定義

表 4-7. 浮動小数点モジュール インターフェイスの定義

モジュール要素名 種類 説明 許容範囲

h_magVect、gh_magVect、
cl_magVect

入力 SFRA による H、GH、CL の振幅測定値を格納する配列への

ポインタ。SFRA がそのベクトルを保存しない場合は NULL 
を渡します。

32 ビット位置へのポインタ。この位

置には、単精度 (32 ビット) 浮動小

数点で振幅ベクトルの値が格納され
ます。

h_phaseVect、gh_phaseVect、
cl_phaseVect

入力 SFRA による H、GH、CL の位相測定値を格納する配列への

ポインタ。SFRA がそのベクトルを保存しない場合は NULL 
を渡します。

32 ビット位置へのポインタ。この位

置には、単精度 (32 ビット) 浮動小

数点で位相ベクトルの値が格納され
ます。

freqVect 入力 SFRA が実行される周波数値の配列へのポインタ。 32 ビット位置へのポインタ。この位

置には、単精度 (32 ビット) 浮動小

数点で周波数ベクトルの値が格納さ
れます。

amplitude 入力 小信号注入の振幅 (pu 単位)。 単精度 (32 ビット) 浮動小数点 
(-1,1)

isrFreq 入力 SFRA ルーチンが呼び出される周波数。 単精度 (32 ビット) 浮動小数点

freqStart 入力 最初の周波数掃引データ ポイントの周波数。 単精度 (32 ビット) 浮動小数点

freqStep 入力 10^(1/(1 ディケードあたりのステップ数))。 単精度 (32 ビット) 浮動小数点

start 入力 SFRA を起動するコマンド。 int16_t

状態 出力 SFRA の状態。SFRA 注入が実行中の場合はゼロ以外、

SFRA 注入がアクティブ / 実行中でない場合は 0。

int16_t

ステータス 出力 SFRA のステータス。1 は SFRA 注入が実行中、0 は SFRA 
注入がアクティブ / 進行中。

int16_t

vecLength 入力 SFRA が実行されるポイントの数。 int16_t
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表 4-7. 浮動小数点モジュール インターフェイスの定義 (続き)
モジュール要素名 種類 説明 許容範囲

freqIndex 出力 SFRA が実行されている freqVect の周波数インデックス番

号。

int16_t (0-vecLength)

storeH 出力 SFRA の構成を反映します。1 の場合は H ベクトルが格納さ

れます。0 の場合は H ベクトルは格納されません。SFRA の
構成中に H mag または位相ベクトルに NULL ベクトルが渡

されたときに発生します。

int16_t (0 または 1)

storeGH 出力 SFRA の構成を反映します。1 の場合は GH ベクトルが格納

されます。0 の場合は GH ベクトルは格納されません。SFRA 
の構成中に GH mag または位相ベクトルに NULL ベクトル

が渡されたときに発生します。

int16_t (0 または 1)

storeCL 出力 SFRA の構成を反映します。1 の場合は CL ベクトルが格納

されます。0 の場合は CL ベクトルは格納されません。SFRA 
の構成中に CL mag または位相ベクトルに NULL ベクトルが

渡されたときに発生します。

int16_t (0 または 1)

speed 入力 掃引の速度を変更するために使用され、1 より大きい必要が

あります。1 の場合、STB の例ではテンプレートの掃引に約 

58 秒かかります。システムでの実際の速度は、測定される周

波数ポイントと SFRA モジュールの呼び出しに使用される 

ISR レートによって異なります。速度の数値が大きいほど、掃

引は遅くなります。

int16_t (1 より大きい)

4.5.4.4 SFRA の使用

SFRA をプロジェクトに統合するには、次の手順を行います。

1. SFRA 機能を有効にするには、図 4-2 に示すように、事前定義シンボル SFRA_ENABLE をプロジェクトプロパティ

に追加する必要があります。
2. SFRA 掃引を開始するには、SFRA オブジェクトを [Watch] ウィンドウに配置します。

3. 図 4-39 に示すように、SFRA 掃引を開始する場合は、SFRA_OBJ.start を 1 に設定します。

図 4-39. SFRA 機能の開始

4. SFRA_OBJ.FreqIndex 変数を監視します。SFRA 掃引が実行されると、変数は徐々に増加します。

5. SFRA_OBJ.FreqIndex が VEC_Length に達すると、SFRA 掃引が完了します。

www.ti.com/ja-jp ハードウェア、ソフトウェア、テスト要件、テスト結果

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

63

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


図 4-40. SFRA のデータ配列

6. SFRA の初期化の一環として、開ループとプラントの振幅と位相は、特定の配列に格納されます。

__attribute__ ((section(".sfradata"))) float32_t plantMagVect[SFRA_FREQ_LENGTH];
__attribute__ ((section(".sfradata"))) float32_t plantPhaseVect[SFRA_FREQ_LENGTH];
__attribute__ ((section(".sfradata"))) float32_t olMagVect[SFRA_FREQ_LENGTH];
__attribute__ ((section(".sfradata"))) float32_t olPhaseVect[SFRA_FREQ_LENGTH];
__attribute__ ((section(".sfradata"))) float32_t freqVect[SFRA_FREQ_LENGTH];

7. これらを [Watch] ウィンドウに配置して、応答を確認および調査します。

8. 掃引が完了したら、CCS 内で [View] -> [MemoryBrowser] をクリックします。

9. Memory Browser 内で、&freqVect と入力して周波数ベクトルを表示し、32 ビット浮動小数点を選択します。

図 4-41. 格納された SFRA ベクトルの Memory Browser ビュー

10. 図 4-41 で囲みで示した [Save Memory] をクリックします。
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11. ポップアップ ウィンドウが表示されます。テキサス・インスツルメンツのデータを選択し、希望する場所にファイル名 

*.dat を指定します。

図 4-42. Save Memory ポップアップ ウィンドウ

12. [Next] をクリックし、Memory Browser から配列の開始アドレスを指定し、次に長さを指定します。
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13. 32 ビット浮動小数点が選択されていることを確認してください。“Finish”をクリックします。

図 4-43. Save Memory オプション

14. これにより、データは *.dat ファイルに保存されます。

15. plantMagVect、plantPhaseVect、olMagVect、olPhaseVect についてこの手順を繰り返すと、5 つの *.dat ファイル

が作成されます。
16. このデータを MATLAB や他のツールで使用する場合は、データを Excel ファイルに入力できます。

17. <project directory>\libraries\SFRA\scripts にある SFRA.xlsx ファイルを Excel で開きます。

18. ファイルは別名で保存することもできます。

19. この Excel シートには 5 列あり、最初の列は周波数データです。

20. 保存した *dat ファイルを開きます。
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図 4-44. .dat ファイルからデータを選択して Excel に入力する

21. 2 行目からファイル末尾までのデータを選択し、Ctrl キーと C キーを押してデータをコピーします。

22. Excel ファイルを開き、対応するベクトルの下にある最初の要素に移動し、Ctrl キーと V キーを押して配列をコピーし

ます。

図 4-45. SFRA データを Excel ファイルにコピーする

23. 各列についてこの手順を繰り返します。

24. Excel ファイルが 5 列すべてで更新されたら、MATLAB スクリプトを使用して SFRA データをインポートします。次

に、sisotool 内のスクリプトを使用して補償器を設計し、安定性解析を実行します。
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4.6 カスタム ボードの製作

4.6.1 新しいカスタム ボードの製作

このセクションでは、モーター駆動用のアプリケーション ボードを設計する方法と、独自のボードで使用するために子のプ

ロジェクトを移行する方法について説明します。

4.6.1.1 ハードウェア設定

カスタム ボードを使用する場合は、マイクロコントローラとゲート ドライバの電源が適正であること、JTAG エミュレータが正

常に接続できていることを確認してください。以降のセクションの説明に従って、リファレンス コードをカスタム ボードと互

換性があるように変更し、セクション 4.4 に示すように、ビルド レベル 1 から開始して、ビルド レベル 4 までコードを実行し

ます。

4.6.1.2 リファレンス コードのカスタム ボードへの移行

リファレンス コードを新しいテキサス・インスツルメンツのモーター ドライバ キットまたはカスタム ボードに移行するには、以

降のセクションで説明するように、モーター ドライバ回路に応じて、user_mtr1.h ファイル内のハードウェア パラメータとモ

ーター制御パラメータを構成し、AM263_xxx.syscfg ファイル、hal.h ファイル、hal.c ファイル内の関連ペリフェラルを構

成する必要があります。 

次のブロック図では、モーター制御設定とテキサス・インスツルメンツの MCU ペリフェラルの構成に使用する関数呼び出

しをまとめています (図 4-46)。

このプロジェクトでは、ハードウェアの構成に関連して、呼び出しが一度だけの HAL 関数がいくつかあります。このような

関数はすべて、ペリフェラルまたはモーター ドライバ IC の構成を処理するものです。

Initialize the HAL Handle: HAL_init() 

(call in sys_main.c, define in hal.c)

Setup HAL with user parameters: 

HAL_MTR_setParams() 

(call in sys_main.c, define in hal.c)

initialize motor control parameters: 

initMotor1CtrlParameters()

(call in sys_main.c, define in motor1_drive.c)

Hardware interrupt instance

Forever Loop Start

run offset calibration: runMotor1OffsetsCalculation() 

(call in sys_main.c, define in motor1_drive.c)

Project Start

図 4-46. HAL の構成とモーター制御設定のブロック図

4.6.1.2.1 ハードウェア ボード パラメータの設定

user_mtr1.h ファイルには、モーター制御用のすべてのユーザー パラメータが格納されます。AD コンバータへの入力に

おける相電流と相電圧の最大値は、ハードウェアに依存するものであり、電流と電圧のセンシング回路および ADC 入力

でのスケーリングに基づいている必要があります。位相電流センサと位相電圧センサの数も、user_mtr1.h ファイルで定

義されます。 これらの値はハードウェアに依存します。

user_mtr1.h ファイルで定義されている構成可能なパラメータはすべて、Excel® スプレッドシートの Motor Control 
Parameters Calculation.xlsx を使用して計算できます。このファイルは
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\examples\universal_motorcontrol_lab\doc にあるプロジェクト フォルダに含まれています。以下のコード

に示すように、太字で示されたパラメータを user_mtr1.h ファイルにコピーしてください。 

//! \brief Defines the maximum voltage at the AD converter
#define USER_M1_ADC_FULL_SCALE_VOLTAGE_V         (57.52845691f)

//! \brief Defines the analog voltage filter pole location, Hz
#define USER_M1_VOLTAGE_FILTER_POLE_Hz           (680.4839141f)     // 47nF

//! \brief Defines the maximum current at the AD converter
#define USER_M1_ADC_FULL_SCALE_CURRENT_A         (47.14285714f)     // gain=10

4.6.1.2.2 モーター制御パラメータの変更

PMSM モーターの user_mtr1.h ファイルに含まれるパラメータは、以下のコードに示すとおりです。モーターのパラメータ

は、モーターのデータシートから確認できます。

#define USER_MOTOR1_TYPE                   MOTOR_TYPE_PM
#define USER_MOTOR1_NUM_POLE_PAIRS         (4)

#define USER_MOTOR1_Rs_Ohm                 (0.38157931f)
#define USER_MOTOR1_Ls_d_H                 (0.000188295482f)
#define USER_MOTOR1_Ls_q_H                 (0.000188295482f)
#define USER_MOTOR1_RATED_FLUX_VpHz        (0.0396642499f)
#define USER_MOTOR1_MAX_CURRENT_A          (6.0f)

4.6.1.2.3 ピン配置の変更

AM263_xxx.syscfg ファイルは、GPIO ピンの機能を設定および構成し、使用するハードウェア モーター ドライバ ボー

ド / キットに応じて、指定されたピンの方向とモードを設定します。カスタム ボード向け、現時点でユニバーサル ラボ コー

ドをサポートしていないテキサス・インスツルメンツのモーター ドライバ EVM 向け、または別のテキサス・インスツルメンツ

の MCU で使用するためにコードを変更する場合、これらの GPIO 割り当ては、モーター ドライバ ボードに適切に対応す

るように変更する必要があります。

4.6.1.2.4 PWM モジュールの構成

SysConfig ファイルは PWM チャネルの設定や構成を定義します。モーター コントローラの PWM 入力に使用される 

PWM チャネルのベース アドレスは hal.h ファイルで定義され、ベース アドレスは hal.c ファイルの PWM ハンドルに割り

当てられます。 図 4-47 に、LP-AM263 と BOOSTXL-3PHGANINV の間の PWM 信号の接続図を示します。

LP-AM263 and BOOSTXL-3PHGANINV 

Combination

INHA/UHEPWM13B

EPWM13A

EPWM3B

EPWM3A

EPWM9B

EPWM9A

INLA/UL

INHB/VH

INLB/VL

INHC/WH

INLC/WL

図 4-47. PWM の接続図

以下に、.syscfg ファイル、hal.h ファイル、hal.c ファイルから、PWM 信号を構成するコードを示します。 

1. PWM モジュールのベース アドレスは、以下に示すように hal.h ファイルで定義されます。

#define MTR1_PWM_U_BASE         CONFIG_EPWM13_BASE_ADDR
#define MTR1_PWM_V_BASE         CONFIG_EPWM3_BASE_ADDR
#define MTR1_PWM_W_BASE         CONFIG_EPWM9_BASE_ADDR
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2. GPIO は、.syscfg ファイルで PWM 出力として設定されます。

図 4-48. PWM モジュールの GPIO 構成

3. 以下のコードは、hal.c ファイルにある HAL_MTR1_init() 関数において、PWM モジュールの対応するベース アドレ

スを PWM ハンドルに割り当てています。以下のコードは、新しいボードやテキサス・インスツルメンツの MCU に適合

させるときに変更する必要はありません。以下のコード ブロックは、コード内で PWM ハンドルがどのように初期化され

るかを示しています。

    // initialize PWM handles for Motor 1
    obj->pwmHandle[0] = MTR1_PWM_U_BASE;        //!< the PWM handle
    obj->pwmHandle[1] = MTR1_PWM_V_BASE;        //!< the PWM handle
    obj->pwmHandle[2] = MTR1_PWM_W_BASE;        //!< the PWM handle

4. 図 4-49 に、EPWM タイム ベースの構成を示します。位相 A の SYNC OUT パルスは、他の PWM の SYNC IN パ
ルスのソースとして使用されます。

図 4-49. EPWM タイム ベースの構成

EPWM アクション クオリファイヤの構成に、LP-AM263 と BOOSTXL-3PHGANINV の組み合わせの EPWM アクシ

ョン クオリファイヤ出力イベントの構成を示します。PWM アクション クオリファイア出力は、ハードウェア ボードに基づ

いて設定する必要があります。
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図 4-50. EPWM アクション クオリファイヤの構成

図 4-51 に、LP-AM263 の EPWM デッドバンドの構成を示します。EPWMxA-B のスワップ出力が、LaunchPad™ 
と Booster Pack™ のハイサイドとローサイドの PWM と一致するかどうかがチェックされます。

図 4-51. EPWM デッドバンドの構成

4.6.1.2.5 ADC モジュールの構成

前述の PWM のセクションと同様に、ADC 接続も、ユニバーサル モーター制御プロジェクトでサポートされていないカス

タム ボードやテキサス・インスツルメンツのモーター制御キット用に変更できます。.syscfg ファイルは、ADC チャネルをモ
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ーター ドライバ ボードに正しく対応するように設定や構成を定義します。例として、LP-AM263 と 

BOOSTXL-3PHGANINV の組み合わせの接続図を 図 4-52 に示します。ADC モジュールの構成について以下の手順

で説明します。

LP-AM263 and BOOSTXL-3PHGANINV 

Combination

ADC2_IN2

ADC3_IN2

ADC3_IN1

ADC4_IN1

ADC0_IN2

ADC2_IN1

ISENA

ISENB

ISENC

VSENA

VSENB

VSENC

ADC1_IN2

VSENVM

図 4-52. ADC の接続図

1. 以下のコードは、hal.h ファイル内の ADC モジュールのベース アドレス、割り当てられたチャネル、SOC の定義を示

しています。SOC 番号については、異なる ADC モジュール (以下の場合はモジュール A とモジュール C) に属する

限り、複数の ADC を同じ SOC 番号に関連付けることができることに注意してください。すべての電流とすべての電

圧をできるだけ近接してサンプリングするようにして、この点を考慮して SOC 番号を構成してください。以下のコード

は、新しいボードやテキサス・インスツルメンツの MCU に適合させるときに変更する必要はありません。以下のコード

は、ADC がどのように初期化されるかを示すだけで、変更は .syscfg ファイルで行うことができます。

#define MTR1_IU_ADC_BASE        CONFIG_ADC1_BASE_ADDR //J7.67 ADC1_AIN2
#define MTR1_IV_ADC_BASE        CONFIG_ADC2_BASE_ADDR //J7.68 ADC2_AIN2
#define MTR1_IW_ADC_BASE        CONFIG_ADC3_BASE_ADDR //J7.69 ADC3_AIN2
#define MTR1_VU_ADC_BASE        CONFIG_ADC3_BASE_ADDR //J7.64 ADC3_AIN1
#define MTR1_VV_ADC_BASE        CONFIG_ADC4_BASE_ADDR //J7.65 ADC4_AIN1
#define MTR1_VW_ADC_BASE        CONFIG_ADC0_BASE_ADDR //J7.66 ADC0_AIN2
#define MTR1_VDC_ADC_BASE       CONFIG_ADC2_BASE_ADDR //J7.63 ADC2_AIN1

#define MTR1_IU_ADCRES_BASE     CONFIG_ADC1_RESULT_BASE_ADDR
#define MTR1_IV_ADCRES_BASE     CONFIG_ADC2_RESULT_BASE_ADDR
#define MTR1_IW_ADCRES_BASE     CONFIG_ADC3_RESULT_BASE_ADDR
#define MTR1_VU_ADCRES_BASE     CONFIG_ADC3_RESULT_BASE_ADDR
#define MTR1_VV_ADCRES_BASE     CONFIG_ADC4_RESULT_BASE_ADDR
#define MTR1_VW_ADCRES_BASE     CONFIG_ADC0_RESULT_BASE_ADDR
#define MTR1_VDC_ADCRES_BASE    CONFIG_ADC2_RESULT_BASE_ADDR

#define MTR1_IU_ADC_CH_NUM      ADC_CH_ADCIN2
#define MTR1_IV_ADC_CH_NUM      ADC_CH_ADCIN2
#define MTR1_IW_ADC_CH_NUM      ADC_CH_ADCIN2
#define MTR1_VU_ADC_CH_NUM      ADC_CH_ADCIN1
#define MTR1_VV_ADC_CH_NUM      ADC_CH_ADCIN1
#define MTR1_VW_ADC_CH_NUM      ADC_CH_ADCIN2
#define MTR1_VDC_ADC_CH_NUM     ADC_CH_ADCIN1

#define MTR1_IU_ADC_SOC_NUM     ADC_SOC_NUMBER0         // SOC0-PPB1
#define MTR1_IV_ADC_SOC_NUM     ADC_SOC_NUMBER0         // SOC0-PPB1
#define MTR1_IW_ADC_SOC_NUM     ADC_SOC_NUMBER0         // SOC0-PPB2
#define MTR1_VU_ADC_SOC_NUM     ADC_SOC_NUMBER1         // SOC1
#define MTR1_VV_ADC_SOC_NUM     ADC_SOC_NUMBER1         // SOC1
#define MTR1_VW_ADC_SOC_NUM     ADC_SOC_NUMBER1         // SOC1
#define MTR1_VDC_ADC_SOC_NUM    ADC_SOC_NUMBER1         // SOC1

#define MTR1_IU_ADC_PPB_NUM     ADC_PPB_NUMBER1         // SOC0-PPB1
#define MTR1_IV_ADC_PPB_NUM     ADC_PPB_NUMBER1         // SOC0-PPB1
#define MTR1_IW_ADC_PPB_NUM     ADC_PPB_NUMBER1         // SOC0-PPB2

2. 図 4-53 に、.syscfg ファイル内の ISR の割り込みソースの定義を示します。

ハードウェア、ソフトウェア、テスト要件、テスト結果 www.ti.com/ja-jp

72 AM263x Arm® ベースの MCU デバイス向けユニバーサル モーター制御のリファレ
ンス デザイン

JAJU933 – APRIL 2024 – REVISED DECEMBER 2024
資料に関するフィードバック (ご意見やお問い合わせ) を送信

English Document: TIDUF67
Copyright © 2025 Texas Instruments Incorporated

https://www.ti.com/tool/LP-AM263
https://www.ti.com/tool/BOOSTXL-3PHGANINV
https://www.ti.com/jp
https://www.ti.com/jp/lit/pdf/JAJU933
https://www.ti.com/feedbackform/techdocfeedback?litnum=JAJU933&partnum=TIDM-02018
https://www.ti.com/lit/pdf/TIDUF67


図 4-53. ADC 割り込みの構成

3. 図 4-54 に、ADC の変換開始トリガのソースを定義します。この ePWM SOC トリガは、コード内でイネーブルにされ

た同じ ePWM SOC、および pwmHandle[0] に関連付けられた同じ ePWM に対応する必要があります。この場合、

EPWM3 A が ADC 用の SOC として使用されます。

図 4-54. ADC 変換開始の構成

4.6.1.2.6 CMPSS モジュールの構成

CMPSS モジュールは、位相電流の過電流監視に使用されます。CMPSS DAC を使用してスレッショルドが設定されて

おり、電流センス アンプの出力がこのスレッショルドを超えると、CMPSS 出力がトリップします。

カスタム モーター ドライバ ボードを使用する場合や、現在のユニバーサル モーター制御プロジェクトでサポートされてい

ないテキサス・インスツルメンツの MCU やモーター ドライバ EVM にコードを移行する場合、ADC ピンと CMPSS モジュ

ールの間の接続は、モーター ドライバとテキサス・インスツルメンツの MCU の接続に基づいて .syscfg ファイルで適切に

変更する必要があります。CMPSS モジュールの内部接続の詳細については、『AM263x Sitara™ マイクロコントローラ 

データシート』の「ADC 信号の説明」の表を参照してください。

.syscfg ファイルは、使用するモーター ドライバ ボードに従って CMPSS モジュールを構成します。例として、LP-AM263 
と BOOSTXL-3PHGANINV の接続図を、図 4-55 に示します。図 4-56 に、CMPSSA のブロック図を示します。

CMPSSA は、COMPL の正の信号に対する多重化可能な入力として、INH と INL を追加サポートしています。
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LP-AM263 and BOOSTXL-3PHGANINV Combination

ADC2_IN2 (CMPSSA5: inH (+IN))

ADC3_IN2 (CMPSSA7: inH (+IN))

ISENA

ISENB

ISENC

ADC1_IN2 (CMPSSA3: inH (+IN))

図 4-55. CMPSS の接続図

図 4-56. CMPSSA のブロック図

各 CMPSS コンパレータはハイとローのコンパレータを備えているため、信号は目的のコンパレータの目的の入力に合わ

せて適切に多重化される必要があります。これらの接続の詳細については、使用するマイクロコントローラのデータシート
の「アナログ ピンと内部接続」の表を参照してください。図 4-57 に、LP-AM263 と BOOSTXL-3PHGANINV の組み合わ

せで位相電流のウィンドウ比較を行う CMPSS コンパレータの構成を示します。DAC 値は、定義された最大電流に基づ

いて、コード内で更新されます。AM263x デバイスの場合、ADCx_AIN1 と ADCx_AIN3 は (INL) にのみ接続されている

ため、正と負の両方の過電流トリップが制限されることに注意してください。TMDSHVMTRINSPIN と TMDSCNCD263 
の組み合わせでは、U 相電流測定に使用する ADC は ADC1_AIN3 に接続されます。

また、LaunchPad または EVM controlCARD で DAC リファレンス電圧と一致する適切な電圧リファレンスを選択すること

に注意してください。たとえば、AM263x LaunchPad では、DAC VREF スイッチ (S1) を使用して AM263x オンダイ 

LDO を選択します。
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図 4-57. CMPSS コンパレータの構成

図 4-58 は、過電流や低電流の場合に EPWM XABR がトリップを行うために、対応する CMPSS CTRIPL と CTRIPH 
を選択することを示しています。

図 4-58. EPWM XBAR の構成
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5 テキサス・インスツルメンツの高電圧評価基板 (TI HV EVM) におけるユーザーの安全のための

一般的な指針

WARNING

テキサス・インスツルメンツの設定および使用の手順に常に従い、すべてのインターフェイス コンポーネントを推奨される

電気的定格電圧および電力制限範囲内で使用してください。電気に関する安全上の注意事項に常に従い、自分自身と
周囲の作業者の安全を確保してください。詳細については、 テキサス・インスツルメンツの技術問い合わせ窓口までご連

絡ください。

警告
警告および手順に従わないと、感電ややけどの危険により、人身傷害、物的損害、あるいは死亡事故が発生
する可能性があります。

TI HV EVM という用語は、電子デバイスが通常オープン フレームの、密封されていないプリント基板アセンブリで提供さ

れていることを意味します。テキサス・インスツルメンツの HV EVM は、開発ラボ環境で使用することを厳密に意図してお

り、高電圧電気回路の開発および応用における電気的安全性の訓練を受け、技能と知識を有する有資格者のみが使用
してください。その他の使用および / または応用は、 テキサス・インスツルメンツにより厳密に禁止されています。資格を有

していない場合は、HV EVM の使用をただちに停止してください。

1. 作業場の安全性

a. 作業領域を清潔で整理整頓された状態に保ちます。

b. 回路への電源投入は、必ず資格を有するオブザーバーの立ち合いの下行います。

c. TI HV EVM およびインターフェイス電子機器に電源を投入する領域には、効果的なバリアと標識を必ず設け、

不用意なアクセスがないように、アクセス可能な高電圧が存在する可能性があることを明記します。
d. 開発環境で使用されるすべてのインターフェイス回路、電源、評価基板、計器、メーター、スコープ、およびその

他関連の装置で 50Vrms/75VDC を超えるものは、緊急電源遮断 EPO で保護された電源タップ内に電気的に

配置する必要があります。
e. 安定した非導電性の作業台を使用します。

f. 適切に絶縁されたクランプおよびワイヤを使用して測定用プローブおよび計器を接続します。可能な限りフリーハ
ンド テストは行わないでください。

2. 電気的安全性
予防措置として、EVM 全体が完全にアクセス可能で、アクティブな高電圧が印加されていると想定します。

a. 電気測定またはその他の診断測定を行う前に、テキサス・インスツルメンツの HV EVM およびすべての入力、出

力、電気負荷の電源を遮断します。TI HV EVM の電源が安全に切断されていることを再確認します。

b. EVM の電源が切断されていることを確認した上で、EVM 回路および測定装置が電気的に導通していると想定

して、必要な電気回路構成、配線、測定装置の接続、およびその他の応用ニーズを実施します。
c. EVM の準備が整ったら、意図されたように EVM に電源を投入します。

警告

EVM に電源が投入されている間、EVM または電気回路に触らないでください。高電圧により感電の危険性

があります。

3. 個人の安全

a. 個人用保護具 (ゴム手袋やサイドシールド付き保護メガネなど) を身につけ、EVM を適切なインターロック付きの

透明のプラスチック箱に入れて保護するなどして、不用意に触ることがないようにします。

安全使用の制限：

EVM は、量産ユニットのすべてまたは一部として使用することを意図していません。
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6 設計とドキュメントのサポート

6.1 デザイン ファイル

6.1.1 回路図

BOOSTXL-3PHGANINV の回路図をダウンロードするには、BOOSTXL-3PHGANINV のデザイン ファイルを参照してく

ださい。

TMDSHVMTRINSPIN の回路図をダウンロードするには、 C2000WARE-MOTORCONTROL-SDK の 

<install_location>\solutions\tmdshvmtrinspin\hardware> フォルダにあるハードウェア ファイルを参照してください。

6.1.2 BOM (部品表)

BOOSTXL-3PHGANINV の部品表 (BOM) をダウンロードするには、BOOSTXL-3PHGANINVV のデザイン ファイルを

参照してください。

TMDSHVMTRINSPIN の部品表 (BOM) をダウンロードするには、 C2000WARE-MOTORCONTROL-SDK の 

<install_location>\solutions\tmdshvmtrinspin\hardware> フォルダにあるハードウェア ファイルを参照してください。

6.1.3 PCB レイアウトに関する推奨事項

6.1.3.1 レイアウト プリント

BOOSTXL-3PHGANINV のレイアウト プリントをダウンロードするには、BOOSTXL-3PHGANINV のデザイン ファイルを

参照してください。

TMDSHVMTRINSPIN のレイアウト プリントをダウンロードするには、 C2000WARE-MOTORCONTROL-SDK の 

<install_location>\solutions\tmdshvmtrinspin\hardware> フォルダにあるハードウェア ファイルを参照してください。

6.2 ツールとソフトウェア

ツール

TMDSCNCD263 TMDSCNCD263 は、HSEC180 controlCARD をベースとする、Sitara™ 高性能マイコンである 

AM263x シリーズ向けの評価 / 開発ツールです。このボードは、新しいアプリケーションを開発する

ための標準化された使いやすいプラットフォームを実現するために、初期評価とプロトタイプ製作用
に設計されています。

Code Composer 
Studio™ 

Code Composer Studio™ IDE は完全統合スイートで、テキサス・インスツルメンツのすべての組

込みプロセッサ (Sitara、DSP、車載、KeyStone)、マイクロコントローラ (SimpleLink™、C2000 デ
ジタル制御、MSP430、TM4C、Hercules)、デジタル電源 (UCD) デバイス、プログラマブル ゲイン 

アンプ (PGA) デバイスのアプリケーションの作成とデバッグを行うことができます。

ARM-CGT-
CLANG 

tiarmclang コンパイラ ツールは、コンパイラ、アセンブラ、リンカなどのソフトウェア開発ツールを提

供しています。これらのツールを使用すると、Arm Cortex-M シリーズや Cortex-R シリーズのコア 

プロセッサにロードして実行するための、C/C++ ソース コードによるアプリケーションを開発できま

す。

SYSCONFIG SysConfig は、ハードウェアとソフトウェアの構成に関する課題の簡素化と、ソフトウェア開発の迅速

化に役立つ設計を採用した構成ツールです。SysConfig は、ピン、ペリフェラル、無線、ソフトウェ

ア スタック、RTOS、クロック ツリーなどのコンポーネントを構成するための直観的なグラフィカル ユ
ーザー インターフェイスを採用しています。SysConfig は、ソフトウェア開発を迅速化するために、

競合の検出、表示、解決を自動的に実行します。

ソフトウェア

MCU-PLUS-
SDK-AM263X 

AM263x MCU+ SDK (マイコン + ソフトウェア開発キット) は テキサス・インスツルメンツの組込みプロ

セッサ向けの統合ソフトウェア プラットフォームであり、セットアップが容易で、サンプルとベンチマーク

とデモをすぐに利用できます。
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MOTOR-
CONTROL-
SDK-AM263X 

MOTOR CONTROL SDK for AM263x には、RTOS ベースと no-RTOS (RTOS を使用しない) ベ
ースのアプリケーションを開発するためのサンプル、ライブラリ、ツールが付属しており、モーターから
の位置センスのリアルタイム通信、Arm R5F CPU や関連ペリフェラルのリアルタイム制御ライブラリが

可能です。

6.3 ドキュメントのサポート

1. テキサス・インスツルメンツ：『モーター制御 SDK ユニバーサル プロジェクトおよびラボ』、ユーザー ガイド

2. テキサス・インスツルメンツ：『AM263x Sitara™ マイクロコントローラ』データシート

3. テキサス・インスツルメンツ：『テキサス・インスツルメンツ製品ファミリの AM263x Sitara™ マイクロコントローラ』、テク

ニカル リファレンス マニュアル

4. テキサス・インスツルメンツ：『AM263x controlCARD ハードウェア』、ユーザー ガイド

6.4 サポート・リソース

テキサス・インスツルメンツ E2E™ サポート・フォーラムは、エンジニアが検証済みの回答と設計に関するヒントをエキスパ

ートから迅速かつ直接得ることができる場所です。既存の回答を検索したり、独自の質問をしたりすることで、設計で必要
な支援を迅速に得ることができます。

リンクされているコンテンツは、各寄稿者により「現状のまま」提供されるものです。これらはテキサス・インスツルメンツの仕
様を構成するものではなく、必ずしもテキサス・インスツルメンツの見解を反映したものではありません。テキサス・インスツ
ルメンツの使用条件を参照してください。

6.5 商標

LaunchPad™, BoosterPack™, controlCARD™, テキサス・インスツルメンツの™, Sitara™, Code Composer Studio™, 
and テキサス・インスツルメンツ E2E™ are trademarks of Texas Instruments.
Arm® and Cortex® are registered trademarks of Arm Limited.
EtherCAT® and PROFINET® are registered trademarks of Beckhoff Automation GmbH.
MATLAB® is a registered trademark of The MathWorks, Inc.
すべての商標は、それぞれの所有者に帰属します。
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重要なお知らせと免責事項
テキサス・インスツルメンツは、技術データと信頼性データ (データシートを含みます)、設計リソース (リファレンス デザインを含みま
す)、アプリケーションや設計に関する各種アドバイス、Web ツール、安全性情報、その他のリソースを、欠陥が存在する可能性のある
「現状のまま」提供しており、商品性および特定目的に対する適合性の黙示保証、第三者の知的財産権の非侵害保証を含むいかなる保証
も、明示的または黙示的にかかわらず拒否します。
これらのリソースは、 テキサス・インスツルメンツ製品を使用する設計の経験を積んだ開発者への提供を意図したものです。(1) お客様
のアプリケーションに適した テキサス・インスツルメンツ製品の選定、(2) お客様のアプリケーションの設計、検証、試験、(3) お客様の
アプリケーションに該当する各種規格や、その他のあらゆる安全性、セキュリティ、規制、または他の要件への確実な適合に関する責任
を、お客様のみが単独で負うものとします。
上記の各種リソースは、予告なく変更される可能性があります。これらのリソースは、リソースで説明されている テキサス・インスツル
メンツ製品を使用するアプリケーションの開発の目的でのみ、 テキサス・インスツルメンツはその使用をお客様に許諾します。これらの
リソースに関して、他の目的で複製することや掲載することは禁止されています。 テキサス・インスツルメンツや第三者の知的財産権の
ライセンスが付与されている訳ではありません。お客様は、これらのリソースを自身で使用した結果発生するあらゆる申し立て、損害、
費用、損失、責任について、 テキサス・インスツルメンツおよびその代理人を完全に補償するものとし、 テキサス・インスツルメンツは
一切の責任を拒否します。
テキサス・インスツルメンツの製品は、 テキサス・インスツルメンツの販売条件、または ti.com やかかる テキサス・インスツルメンツ
製品の関連資料などのいずれかを通じて提供する適用可能な条項の下で提供されています。 テキサス・インスツルメンツがこれらのリソ
ースを提供することは、適用される テキサス・インスツルメンツの保証または他の保証の放棄の拡大や変更を意味するものではありませ
ん。
お客様がいかなる追加条項または代替条項を提案した場合でも、 テキサス・インスツルメンツはそれらに異議を唱え、拒否します。
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